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Legal Notices 
 

IMPORTANT 
1. All legal terms and safety and operating instructions should be read thoroughly before 

the product accompanying this document is installed and operated. 

2. This document should be retained for future reference. 

3. Attachments, accessories or peripheral devices not supplied or recommended in 

writing by Pointer Telocation Ltd. May be hazardous and/or may cause damage to the 

product and should not, in any circumstances, be used or combined with the product. 

General  

The product accompanying this document is not designated for and should not be used in 

life support appliances, devices, machines or other systems of any sort where any 

malfunction of the product can reasonably be expected to result in injury or death.  

Customers of Pointer Telocation Ltd. Using, integrating, and/or selling the product for use 

in such applications do so at their own risk and agree to fully indemnify Pointer Telocation 

Ltd. For any resulting loss or damages.  

Warranty Exceptions and Disclaimers 

Pointer Telocation Ltd. Shall bear no responsibility and shall have no obligation under the 

foregoing limited warranty for any damages resulting from normal wear and tear, the cost 

of obtaining substitute products, or any defect that is (i) discovered by purchaser during 

the warranty period but purchaser does not notify Pointer Telocation Ltd. Until after the 

end of the warranty period, (ii) caused by any accident, force majeure, misuse, abuse, 

handling or testing, improper installation or unauthorized repair or modification of the 

product, (iii) caused by use of any software not supplied by Pointer Telocation Ltd., or by 

use of the product other than in accordance with its documentation, or (iv) the result of 

electrostatic discharge, electrical surge, fire, flood or similar causes.  Unless otherwise 

provided in a written agreement between the purchaser and Pointer Telocation Ltd., the 

purchaser shall be solely responsible for the proper configuration, testing and verification 

of the product prior to deployment in the field. 

POINTER TELOCATION LTD.’S SOLE RESPONSIBILITY AND PURCHASER’S SOLE REMEDY 

UNDER THIS LIMITED WARRANTY SHALL BE TO REPAIR OR REPLACE THE PRODUCT 

HARDWARE, SOFTWARE OR SOFTWARE MEDIA (OR IF REPAIR OR REPLACEMENT IS NOT 

POSSIBLE, OBTAIN A REFUND OF THE PURCHASE PRICE) AS PROVIDED ABOVE.  

POINTER TELOCATION LTD. EXPRESSLY DISCLAIMS ALL OTHER WARRANTIES OF ANY 

KIND, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION ANY IMPLIED 

WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, SATISFACTORY 

PERFORMANCE AND FITNESS FOR A PARTICULAR PURPOSE.  IN NO EVENT SHALL 

POINTER TELOCATION LTD. BE LIABLE FOR ANY INDIRECT, SPECIAL, EXEMPLARY, 

INCIDENTAL OR CONSEQUENTIAL DAMAGES (INCLUDING WITHOUT LIMITATION LOSS 

OR INTERRUPTION OF USE, DATA, REVENUES OR PROFITS) RESULTING FROM A BREACH 

OF THIS WARRANTY OR BASED ON ANY OTHER LEGAL THEORY, EVEN IF POINTER 

TELOCATION LTD. HAS BEEN ADVISED OF THE POSSIBILITY OR LIKELIHOOD OF SUCH 

DAMAGES.  
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Intellectual Property 

Copyright in and to this document is owned solely by Pointer Telocation Ltd.  Nothing in 

this document shall be construed as granting you any license to any intellectual property 

rights subsisting in or related to the subject matter of this document including, without 

limitation, patents, patent applications, trademarks, copyrights or other intellectual 

property rights, all of which remain the sole property of Pointer Telocation Ltd.  Subject to 

applicable copyright law, no part of this document may be reproduced, stored in or 

introduced into a retrieval system, or transmitted in any form or by any means 

(electronic, mechanical, photocopying, recording or otherwise), or for any purpose, 

without the express written permission of Pointer Telocation Ltd.  

© Copyright 2018. All rights reserved.  
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1 Introduction 

1.1 About This Document 

This document describes the Cellocator Programmer, which enables you to perform the 

following: 

 Modify a PL file to suit your communication needs. 

 Upload and download PL files to Cellocator units via its serial interface. 

 Test and debug units using a variety of features, including a platform manifest, the 

ability to test a unit’s inputs and outputs, and the ability to forward data to a wireless 

channel. 

The Cellocator Programmer is mainly used for the initial configuration of a unit, and 

typically communication settings such as the destination IP address, target port phone, 

and SMS numbers. 

There are actually two methods of configuring the Cellocator unit: 

 Using a RS232 cable connected to the Programmer. 

 Via OTA using the Communication Center. 

The Cellocator Programmer is designed for wire communications with Cellocator units via 

a serial port.  

This document describes how to configure the unit with the RS232 cable only. 

---------------------------------------------------------------------------------------------------- 

NOTE: This guide does not describe each of the parameters available within a PL file. For 

further information about specific parameters, refer to the Cellocator Programming Manual.  

---------------------------------------------------------------------------------------------------- 

1.2 Abbreviations 

Abbreviation Description 

Cello-IQ Cellocator Safety and Eco-driving monitoring device 

CC Communication Center 

CSA Cellocator Safety Application 

CM CSA Manager 

CAN Controller Area Network 

CCC Command and Control Center 

DB Database 

FMS Fleet Management System 

OTA Over the Air 

PGN Parameter Group Number 
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Abbreviation Description 

RMS Root Mean Square 

RSSI Received Signal Strength Indication 

SMS Short Message Service (GSM) 

1.3 Revision History 

Version Date Description 

1.0 May 30 2014 Separation from the Evaluation Manual. 

Reorganization and editing of the content. 

Add CAN Editor. 

1.1 November 10, 2014 Updated the CAN Editor 

1.2 February 8, 2015 Added the Nano Editor 

1.3 May 3, 2015 Removal of the following archive products: 

Cello-F 

Cello-R 

Cello-IQ legacy 

CR200 

CelloTrack 

Compact CAN 

1.4 May 18, 2015 Updated Selecting the correct PL for a Cellocator 

Unit section 

1.5 July 6, 2015 Added Protecting Unit Configuration Memory section 

1.6 November 9, 2015 Updated the Nano Editor 

1.7 December 22, 2015 Tech Writer edits plus new Find feature 

1.8 April 20, 2016 Reworked CAN Editor section updated. 

1.9 September 12, 

2016 

Updated the CAN editor due to CANiQ 

improvements and updated the Nano / MultiSense 

Editor due to integrating the MultiSense with the 

Cello via the BT Extender. 

1.10 September 26, 

2016 

Further updates to the CAN Editor section and BT 

Extender compatibility. 

1.11 October 31, 2016 Removal of AutoMode (Frame Format) in CAN Editor 

New Refresh icon in the Programmer’s 

Configuration dialog box 

Right-click Parameter Help option 

Added new copy, cut and paste keyboard 
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Version Date Description 

functionality: Ctrl+Shift+C, Ctrl+Shift+X, 
Ctrl+Shift+V 

Select multiple parameters for editing 

New Export to XML or Import from XML options 

in Programmer 

New Platform Manifest window 

Added “Old FW Compatibility Mode” alert in CAN 

Editor 

Double-click on any warning or error message to 

jump to the relevant parameter or operator in the 

Diagram View 

PL signature Lock and Restore 

Double-click on Operator to open properties 

Press Alt + Double-click to automatically jump 

to the selected parameter or operator in the Table 

View 

When selecting RX Only Mode, additional Data 

columns (Data0 – Data7) are displayed in the 

Custom Queries tab 

Right-click on image icons in CAN Editor (OBDII 

Parameters tab) to select external image 

1.12 December 7, 2016 New section: Communication with Cello units 

equipped with the BT Extender specific only to Cello 

units paired with MultiSense devices. 

Rearrange Working with the Nano / MultiSense 

Editor chapter separating instructions for 

MultiSense devices paired with Nano to MultiSense 

devices paired with Cello.  

1.13 March 1, 2017 Revisions to the Working with the CAN Editor 

section, including new screenshots, renaming of 

tabs, a new section The Information Tab and 

changes due to encryption of certain parameters, 

queries and filters supplied by Cellocator in version 

36n and above. 

1.14 November 1, 2017 Revisions to the Working with the Nano / 

MultiSense Editor chapter, to include the Nano 

Quick Start application (chapter is now called 

Working with the Nano application suite). 

1.15 January 2, 2018 Updates to Working with the CAN Editor chapter to 

reflect UI changes in 36v. 
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2 Installing the Cellocator Programmer 

The Cellocator Programmer is installed as part of the Cellocator Evaluation Suite. 

 To install the Evaluation Suite: 

1. Double-click the Evaluation suite setup [version number] Installer Package file. 

2. In the displayed Installation Wizard Welcome screen, click Next. 

3. Select the relevant installation type: Typical, Custom or Complete. Note that 

whichever type you select, the Cellocator Programmer is automatically installed. 

4. Proceed with the wizard's onscreen instructions. 

5. Upon successful completion of the installation, click Close to close the wizard.  

The Cellocator Programmer is installed. 

----------------------------------------------------------------------------------------- 

NOTE: When the installation is complete, verify that no error messages were 

generated, the installation folder has been created in the selected destination, and 

the Programmer and other debugging tools appear in the Start menu, as shown 

below. 

----------------------------------------------------------------------------------------------- 

 

Refer to the Cellocator Evaluation Suite Manual for further details. 
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3 Getting Started with the Cellocator Programmer 

This section describes the Cellocator Programmer window and its components, and how to 

initially set up and configure the Cellocator Programmer. 

3.1 Cellocator Programmer Window 

This section introduces the Cellocator Programmer window and its various components. 

 Menu Bar 

 Toolbar 

 Address Bar 

 PL Pane 

 Main Pane 

 

3.1.1 Menu Bar 

The menu bar contains a number of menu options that enable you to fully operate the 

Cellocator Programmer, as listed in the table below. 

Menu Name Description 

Menu bar

Toolbar

Address bar

PL pane

Main pane
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Menu Name Description 

File Provides typical basic Windows functionality, including opening 

and saving files, and exiting the application, plus additional 

functionality such as including configuration values within the PL 

file, merging PL files, loading PL templates, and saving and 

loading memory maps.  

Note that memory maps are the pure data of the PL file 

parameters with their actual addresses in the memory of the 

device, without any textual descriptions.  

Edit Enables you to cut, copy and paste data. You can also perform 

these basic Windows functions from the right-click menu, or via 

the following keyboard shortcuts: Ctrl+Shift+C, Ctrl+Shift+X, 

Ctrl+Shift+V. 

Search Enables you to search for parameters by their address or by 

their actual parameter name. Refer to the Searching for 

Parameters section for further information.  

View Enables you to customize the view of the Programmer panes 

according to your preferences. Refer to the Modifying your 

Programmer View section for further information. 

Communication Provides access to the features that are also included on the main 

toolbar. Refer to the Toolbar section for further information.  

 

CAN Enables you to work with the CAN filter editor (for Compact CAN 

– this is an archived product, for further information please 

contact Customer Support).  
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Menu Name Description 

Help Provides information about the Cellocator Programmer version. 

Note that an additional Parameter Help option is available when 

right-clicking on a parameter. This option provides additional 

information on the selected parameter via an HTML page. 

3.1.1.1 Modifying your Programmer View 

From the View menu you can customize the view of the Cellocator Programmer window in 

a variety of ways. Apart from the usual Windows-type options, such as viewing the 

content in List, Tiles or Details format, you can also choose to display the main screen in 

Parameter or Memory (or hexadecimal) format. 

It is recommended to switch to the Details format directly, otherwise the values are not 

monitored. 

Note that you can also use the  and  toolbar icons to toggle between Parameter or 

Memory format. 

 To display the main screen in Parameters format: 

Select View>Page>Parameters. The Parameter format view is displayed, as shown on 

page 11. This is the default view when first launching Cellocator Programmer.  

 To display the main screen in Memory format: 

Select View>Page>Memory. The Memory format view is displayed (a memory map of 

the PL parameters in pure data format), as shown below. 
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 To display the Log window: 

Select View>Log Window. The Log window displays raw data of the communication 

between the unit and the Cellocator Programmer in binary format, as shown below. 

 

3.1.2 Toolbar 

From the Programmer toolbar you can perform a variety of actions, as described in the 

following table. For further explanations of the various toolbar options, refer to the 

Cellocator Programmer Functionality section on page 32. 

Icon Description 

 
Create a new PL file (this is normally used only by Cellocator personnel, as 

the user usually loads pre-configured PL files).  

 
Browse to open an existing PL file on your computer. 

 
Save the current PL file. 

 
Includes the configuration values in the parameter library: this is the 

default configuration meaning all names, details and values of the 

parameters are saved. By default, the icon button is pressed. 

If you click the button to deactivate this feature, only parameter definitions 

(such as caption, address, units, and hints) are saved to the library, without 

values.  
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Icon Description 

 
Sends a basic query to the unit. The unit replies with the unit's ID, firmware 

and hardware type and modem type of the connected unit. Refer to the 

Querying the Cellocator Unit section on page 33 for further information.  

 
Enables you to upload values currently programmed in the unit’s 

configuration memory. After the upload the values are monitored by 

relevant parameters.  

 
Enables you to download modified parameters and save their values to the 

unit’s configuration memory. Refer to the Modifying Parameters in the 

Cellocator Programmer section on page 28 for further information. 

Note that after downloading a modified PL file, the unit must be reset by 

power disconnection or by serial/OTA reset. 

 
Enables you to download the modified parameters values to the unit's 

memory, but also includes verification of the programmed data. 

 
Provides debug information regarding the connection status of the unit. 

Refer to the Master Unit Status Request section on page 34 for further 

information. 

 
Enables you to test the unit's inputs and outputs. Refer to the Testing a 

Unit's Inputs and Outputs section on page 34 for further information. 

 
Enables you to set up a bidirectional communication link between the unit 

serial port and the cellular network, thus allowing communication from the 

Mobile Data Terminal, connected to the unit serial port, to the back office 

application. Refer to the Forwarding Data to wireless channel section on 

page 36 for further information. 

 
Allows the activating of voice features (e.g. initiate call, received call, reject 

call, etc.) for testing and integrating voice devices such as the Handsfree 

module. Refer to the Voice Call Management section on page 37 for further 

information. 

 
Manufacturing Info Request - to be used by Customer Support. Refer to the 

Manufacturing Info Request section on page 38 for further information. 

 
Learn vehicle locking/unlocking sequences. This function is relevant to the 

Cello-R unit only (this is an archived product, for further information please 

contact Customer Support).  

 
Allows the sending of AT commands to the unit’s cellular modem, mainly for 

debug purposes. Refer to the Forwarding AT Command section on page 39 

for further information. 

 
Platform Manifest. Provides maintenance information about the unit’s 

hardware and software. Refer to the Platform Manifest section on page 40.  

 
Enables the configuration of a list of prioritized operators for roaming 

purposes. Refer to the Configuring Roaming Settings section on page 42 for 

further information. 
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Icon Description 

 
Enables you to define the frequency of “time events” by linearly adjusting 

according to the speed of the vehicle. Refer to the Configuring VTrek 

Settings section on page 43 for further information. 

 
Enables you to test the usage counters. Up to two inputs can be defined. 

Refer to the Configuring Counters Inputs Settings section on page 40 for 

further information.  

 
Enables you to define the authentication parameter. Refer to the 

Authentication Table section on page 43 for further information. 

 
Compact CAN Filters parameters editor - relevant only for Compact CAN 

units (this is an archived product, for further information please contact 

Customer Support).  

 
Opens the CAN Editor (for Cello-CANiQ units). Refer to the Working with the 

CAN Editor section on page 46 for further information. 

 
Enables you to reset the unit. The actual reset is initiated 5 seconds after 

receipt of the reset command.  

 
Opens the Nano Editor (for CelloTrack Nano and MultiSense devices). Refer 

to the Working with the Nano Editor section on page 80 for further 

information. 

 
Opens the Geo-fence Editor: currently not implemented. 

 
For use by Cellocator personnel only.  

 
Enables you to activate shipment mode in the unit (available for the Cello 

and CR300 variants with battery only).  

 
Displays the Cello Platform Manifest, which provides more detailed 

hardware and software maintenance information than the standard Platform 

Manifest (see above).  

 
Assists in browsing between PL folders (click to go back to the previous 

folder view). 

 
Assists in browsing between PL folders (click to go forward to the next 

folder view in the browsing sequence). For example, if you clicked back a 

few steps you can click this button to return to your current folder view. 

 
Assists in browsing between PL folders (click to go up one level). 

 
Displays the default view of PL folders and parameters. Refer to the 

Modifying your Programmer View section on page 13 for further 

information. 

 
Displays a memory map. The memory map enables you to view the real 

allocation of configuration memory values, without any translation. Refer to 

the Modifying your Programmer View section on page 13 for further 

information. 
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Icon Description 

 
Provides access to the configuration of communications and memory 

parameters. Note that only the Communication tab should be used; other 

tabs are for use by Cellocator personnel only. Refer to the Configuring 

Communications and Memory Parameters section on page 28 for further 

information. 

 
Enables you to open/close the Com Port. 

 The communication port is open. 

 The communication port is closed. 

3.1.3 Address Bar 

The Address bar is mainly used to show the current location in the PL tree.  

In order to browse the PL tree, you can use the Address bar to access the parameter. 

Enter the correct path in the text area (for example: 16_Geo-Fence\) and then click Go. 

You can also click the dropdown box arrow to select a previously used address and then 

click Go to select this address.   

 

3.1.4 PL Pane 

The PL pane lists the various sections of the PL file, as shown in the example below. 

  

The PL pane also provides an additional method of searching for parameters. By drilling 

down to the relevant section, you can find the relevant parameters (which are displayed 

in the Main pane) for a specific section simply by clicking on the section.  
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3.1.5 Main Pane 

The Main pane displays the parameters for the section you selected in the PL pane or 

entered in the Address bar. To modify a parameter's value, double-click on the parameter 

and in the displayed window modify as required. Refer to the Modifying Parameters in the 

Cellocator Programmer section for further information. 

Note that you can modify the view of the parameters displayed in the Main pane, as 

described in the Modifying your Programmer View section. 

 

Note that a Parameter Help option is available when right-clicking on a parameter. This 

option provides additional information on the selected parameter via an HTML page. 

3.2 Starting the Cellocator Programmer  

The Cellocator Programmer is installed as part of the Evaluation Suite package. To start 

the Cellocator Programmer software, perform the following steps: 

1. Connect the COM port of the unit to a COM port with a known port number. 

2. If the unit is connected to a simulator, make sure the Ignition switch of the simulator 

is in the ON position. 

3. Open the Cellocator Programmer by selecting Start > Programs > Cellocator> 

Cellocator Programmer. The application opens with an empty programming 

environment, as shown below. 
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4. In order to be able to communicate with the unit, from the Communication menu, 

select Configuration. The following screen is displayed. 

 

5. In the Communication Port field select the port number used for communication 

with the unit (0 in the example above).  

Alternatively, click  to display a list of the available ports on your computer. 

6. The Baud Rate should be set to 115000.  

7. Click OK. 

In order to be able to change the parameters in the unit memory and to select the 

appropriate PL for the unit you should query the Cellocator unit information. 
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 To query the unit: 

From the Cellocator Programmer toolbar, click Query ( ), or select Communications > 

Query unit from the menu bar. The unit responds with its information, as shown below. 

 

The Programmer saves the Unit Number for future communication with the unit. 

------------------------------------------------------------------------------------------------ 

NOTE: You can also use OTA (through Parsing Message Type 0 and also via the Cellocator 

Communication Center) to locate Cellocator unit information. These methods are 

described in the Cellocator Programming Manual.  

------------------------------------------------------------------------------------------------ 

3.3 Communication with Cello units equipped with the BT 
Extender 

The Cellocator Programmer can communicate with Cello units equipped with the BT 

Extender via Bluetooth. Note that the Evaluation Suite should be installed on a PC or 

laptop equipped with Bluetooth which supports BT2.1. 

To pair the Programmer with the Cello unit and the BT Extender perform the following 

steps: 

1.    Make sure that the BT Extender is connected to the Cello unit. 

2.    In your computer’s Control Panel, access Hardware and Sound/Bluetooth Devices and 

click Add a device. A list of BT devices is displayed. 

3.    Select the BT Extender, identified by its BT friendly name (in a format of BT-

extnnnnnn, where the nnnnnn stands for the unit ID of the attached Cello). No 

password is required. 

4.    In the Control Panel, access Device Manager to identify the COM port assigned to the 

BT Extender. 

5.    Proceed from Step 3 of the Starting the Cellocator Programmer section and select the 

COM port number when required. 
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4 Selecting the correct PL for a Cellocator Unit 

This section describes how to select the correct PL for your Cellocator unit, and also 

includes how to merge two existing PL files into one new PL file.  

4.1 Determining the correct PL file name 

In order to select the correct PL for your Cellocator unit from the Cellocator website, the 

PL file name should include the following parameters: 

 The product name 

 The unit's HW version 

 The unit's firmware version 

For example the PL file hw_14_fw_33u_Cello-IQ30_V2278 relates to the product 

Cello-IQ30 with HW type 14 and FW version 33u. 

The HW version and the FW version are provided in the unit query information, as 

described in the previous section. 

You can retrieve the product name using a lookup table in the Cellocator Wireless 

Communication Protocol, in the Unit’s Hardware, Firmware and Protocol Versions 

section. 

In the example described in the previous section: 

 Hardware Version = 24 

 Software Version = 31x 

 Modem Type = Telit GE864 

 The associated product according to the lookup table is Cello-F. 

4.2 Loading the PL file in the Programmer 

There are three possible sources for the appropriate PL file: 

 Downloading the default PL from the website 

 From an existing file (on your computer) 

 Uploading the PL from the connected unit 

Note that you can also merge existing PL files into a new PL file, which is automatically 

loaded in the Programmer upon completion of the merge. Refer to page 23 for further 

details. 

4.2.1 Downloading the PL from the Cellocator Website 

Once you have the correct unit information (product name, firmware version and 

hardware type), you can download the relevant default PL from the Cellocator website. 

PL files for newer FW versions and products can be found as part of FW release packages, 

on the FW & PL Released Packages page. 

PL files for older FW versions and products can be found under PL Files (Programming 

Library). 

http://www.cellocator.com/?s2member_file_download=EvaluationAndIntegration/Cellocator%20Wireless%20Communication%20Protocol.pdf
http://www.cellocator.com/?s2member_file_download=EvaluationAndIntegration/Cellocator%20Wireless%20Communication%20Protocol.pdf
http://www.cellocator.com/knowledgebase/fw-released-packages/
http://www.cellocator.com/knowledgebase/fw-releases/pl-files-programming-library-2/
http://www.cellocator.com/knowledgebase/fw-releases/pl-files-programming-library-2/
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For the example we used above, the PL required is: Fw. 31x for Cellocator Cello-F (HW 

24), which can be found on the following page: 

http://www.cellocator.com/knowledgebase/fw-releases/pl-files-programming-library-

2/cellofamily-pl-files/  

Note that the above links require access to the Cellocator Knowledge Base section on the 

website. When downloading, save the default PL file in the relevant location on your 

computer; when required, it can be loaded in the Programmer. 

4.2.2 From an existing file 

The relevant PL file may already be located on your computer somewhere; perhaps you 

already downloaded it or it was sent to you by Cellocator Support or you have already 

prepared it for a specific fleet. 

 To load the PL file in the Programmer: 

In the File menu of the Programmer window, click Open and chose the PL file, 

OR 

In the Programmer window, click the Open icon to load the relevant PL file. 

4.2.3 Uploading the PL from the connected unit 

A PL can be uploaded from a connected unit only if an appropriate PL file has been already 

loaded in the Programmer. 

Upload the entire unit’s configuration memory by clicking  (Upload Parameters icon) 

in the Programmer window, and save it to the appropriate PL file. 

When loaded, the PL file settings are displayed in the Programmer window, with the PL 

name in the first line of the PL pane, as shown below. Note that depending on the product 

type, the contents of the window below may differ; refer to section ‎4.3 for further details. 

 

http://www.cellocator.com/?s2member_file_download=PLFiles/CelloFamily/hw_24_fw_31x_Cello-F_V211.rar
http://www.cellocator.com/?s2member_file_download=PLFiles/CelloFamily/hw_24_fw_31x_Cello-F_V211.rar
http://www.cellocator.com/knowledgebase/fw-releases/pl-files-programming-library-2/cellofamily-pl-files/
http://www.cellocator.com/knowledgebase/fw-releases/pl-files-programming-library-2/cellofamily-pl-files/
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4.3 Merging PL files 

PL files can be merged to create a new PL file; the new file includes the configuration 

settings of the two merged files. 

 To merge PL files: 

1. Using the File>Open menu option, open the relevant PL file. This PL file is the “source” 

file used in the merge process. 

2. From the File menu, select Merge.  

3. In the displayed confirmation message, which informs you that the currently loaded PL file 

(the “source” file) will be modified, click Yes to continue. The Open reference (old) PL 

window is displayed, via which you select the relevant PL file you want to merge with the 

“source” file. 

4. After selecting the relevant file, the Merge Results window is displayed, as shown below. 

 

Note that you can double-click on a change in the list to jump to the new parameter 

location in the PL file in the PL pane. 

5. Click Export to export the list of merged results to a .CSV file. 

6. Click OK to close the Merge Results window. The new merged file is displayed in the 

Programmer window, indicated by the suffix “_Merged_<date>_” in the PL pane. 

Note that the merged file is a new file; the source PL file you selected in Step 1 and the 

PL file you selected in Step 3 are not deleted. 
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4.4 The different PL layouts 

This section describes the various layouts for each of the PLs available for each of the 

main Cello products, and the differences between each PL. 

4.4.1 Cello-IQ 30 PL 

 

The Cello-IQ 30 PL contains all the parameters required for the Fleet Management 

application. These parameters are arranged in groups which are shown in the PL pane. 
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4.4.2 Cello-CANiQ PL 

 

The Cello-CANiQ PL includes Fleet Management parameters similar to the Cello-IQ30. In 

addition, it includes the parameters for the CSA application (08 CSA Configuration) and 

the parameters for the CAN capabilities (10 CAN).  

The CSA parameters are also available for the Cello-IQ 40/50. 
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4.4.3 CR300 PL 

 

The CR300 PL includes subset of the Fleet Management parameters available for the 

Cello-IQ 30. Unavailable parameters are removed or grayed. 

4.4.4 CelloTrack PL 

 

The CelloTrack PL includes all appropriate Fleet Management parameters similar to the 

Cello-IQ. CelloTrack parameters and its unique capabilities can be updated in the 08 

CelloTrack section. 
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4.4.5 CelloTrack Nano PL 

 

------------------------------------------------------------------------------------------------ 

NOTE: When double-clicking on a Nano-designated PL, the Nano Quick Start application 

is launched (see page 80). To edit the parameters beyond the basic settings, click on 

Advanced Settings > Global Advanced Settings (or press CTRL+F) to open the 

Cellocator Programmer (also known as the Nano (Advanced Mode)), as shown above.  

------------------------------------------------------------------------------------------------ 

CelloTrack Nano parameters and its unique capabilities are spread throughout several 

areas of the PL (shown expanded in the screenshot above). 

The CelloTrack Nano PL includes all appropriate parameters to configure its internal 

sensors, data logger function, LEDs and buzzer, BLE, MultiSense units and unique 

features such as airplane mode. 

The PL also comprises various predefined templates (sets of parameters) that you can 

choose to access certain use-cases more quickly, as described on page 89. 
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5 Modifying Parameters in the Cellocator 

Programmer 

This section describes how to modify a parameter in Cellocator Programmer once you 

have downloaded or accessed the relevant PL file (see the previous section), and includes 

the following: 

 Locating parameters to modify 

 Modifying a parameter 

 Saving the modified PL file and downloading it to the unit 

 Configuration scenarios 

---------------------------------------------------------------------------------------------------- 

NOTE: This guide does not describe the values of each PL parameter. Parameter values 

are listed in the Cellocator Programming Manual.  

---------------------------------------------------------------------------------------------------- 

5.1 Locating Parameters to Modify 

This section describes the various ways you can search for parameters within a PL file, 

including the following: 

 Using the Address bar (see the Address Bar section for further information). 

 Drilling down within the PL pane or Main pane (see the PL pane and Main pane 

sections for further information). 

 Using the menu bar, as described below. 

From the menu bar, select Search > by Address to display the following: 

 

From the menu bar, select Search > by Parameter Name to display the following: 

 

Note that you can only enter part of the parameter's name. 

You can find a list of all parameters and their descriptions in the Cellocator Programming 

Manual.  
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Once you have located the relevant parameter, you can then proceed to modify it, as 

described in the following section. 

Another alternative is to use the Find feature. From the menu bar, select Search > Find 

(also available via the keyboard shortcut of Ctrl+F, as in standard Microsoft Office 

applications), to display the Find Parameters window shown below. 

 

In this window you can search for both addresses and parameter names simultaneously. 

You can also search for specific values in the enumeration fields and comments by 

entering the relevant search criteria, selecting the relevant checkbox, and then clicking 

Find. 

Once you have a number of search results displayed, clicking Search > Find Next (F3) 

jumps directly to the next found entry in the list of results. 

5.2 Modifying a Parameter Value 

Modifying parameter values is easily done once you have located the relevant parameter 

(see the previous sections). 

 To modify a parameter value: 

1. After locating the parameter in the Main pane, double-click on the parameter to 

display the parameter value dialog box. Generally, there are two types of values you 

can enter.  

 There are parameters that can be defined with one of two values, usually selected 

from a dropdown list, as shown in the example below (Disable/Enable). 
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 There are other parameters that can be defined with a specific value, such as a 

decimal value, as shown in the example below.  

 

------------------------------------------------------------------------------------------------ 

NOTE: You can also select multiple parameters for editing (using standard Windows 

selection methods); then right-click and select Properties in the displayed popup, and 

modify as required.  

 

Before modifying a parameter you should always verify via the Cellocator 

Programming Manual the specific values available for a parameter.  

------------------------------------------------------------------------------------------------ 

You can also view an information tooltip for each parameter by hovering over the 

parameter, as shown below. In addition, a Parameter Help option is available when 

right-clicking on a parameter. This option provides additional information on the 

selected parameter via an HTML page. 

 

2. Enter or select the relevant value for the parameter. 

3. Click OK. 

------------------------------------------------------------------------------------------------ 

NOTE: You can also import parameters to and from an XML file, meaning you can edit 

parameters in an XML editor and then re-import them into the PL file. Right-click on 

any parameter node and select Export to XML or Import from XML.  

------------------------------------------------------------------------------------------------ 

5.3 Saving the Modified PL File 

This section describes how to save the PL file and how to download the modified PL file to 

the Cellocator unit. 

 To save the modified PL file: 

1. After modifying the PL file, click  on the toolbar, or from the File menu select 

Save. 
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2. Download the modified parameters to the unit’s configuration memory by clicking 

 or by selecting Query from the Communications menu option. When the 

download has completed, a confirmation message is displayed. 

3. Reset the unit by clicking on the toolbar. At this stage the unit dials up to GPRS 

and connects to the server. As a result, the unit will now be monitored by the 

Communication Center application. 

---------------------------------------------------------------------------------------------------- 

NOTE: After downloading a modified PL file, the unit must be reset by power 

disconnection or by a serial/OTA reset.  

---------------------------------------------------------------------------------------------------- 

5.4 Protecting unit configuration memory 

In order to protect the configuration memory range from being changed when 

downloading a new PL to the unit, from the Communication menu select Configuration 

and then click the Memory tab, as shown below.  

 

The Protected Blocks area lists several memory ranges provided by Cellocator. They 

should not be modified. 

You can add additional memory ranges according to the example provided in the screen 

above. 

Please note that for proper operation of the Cellocator+ application, the protected 

memory blocks ranges should be arranged in memory-range ascending order. 
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6 Cellocator Programmer Functionality 

This section provides details of the Cellocator Programmer functionality (via the 

Programmer menu bar and toolbar), which can be divided into three main areas: 

 Maintenance: the Programmer tools that enable you to monitor, test and analyze 

how the Cellocator unit is functioning.  

 PL Editing: the Programmer tools with which you can actually program and edit the 

PL file. 

 PL Management: the Programmer tools that enable you to manage the various PL 

files, such as opening and saving PL files, as well as downloading parameter values.  

 

6.1 Maintenance 

This section includes the following: 

 Querying the unit, page 33 

 Master unit status request, page 34 

 Testing a unit's inputs and outputs, page 34 

 Forwarding data to wireless channel, page 36 
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 Voice call management, page 37 

 Manufacturing info request, page 38 

 Forwarding AT Command, page 39 

 Platform manifest, page 40 

 Configuring counters inputs settings, page 40 

 Resetting the unit (see the Toolbar section for further information) 

 Custom commands, page 41 

 Activating shipment mode (see the Toolbar section for further information) 

 Cello Platform Manifest, page 41 

 Configuring Communications and Memory Parameters, page 41 

 Opening/closing COM port (see the Toolbar section for further information) 

6.1.1 Querying the Cellocator Unit 

Clicking  in the Cellocator Programmer toolbar initiates unit interrogation and the unit 

replies with its ID, as shown below.  
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6.1.2 Master Unit Status Request 

The Master unit status request window provides debug information regarding the 

connection status of the unit. You can verify the status of current inputs and outputs, and 

also modify the time range of the updates (in seconds).  

 

6.1.3 Testing a Unit's Inputs and Outputs 

The Testing window, as shown below, is used to test the unit's inputs and outputs. Inputs 

can be read and outputs activated by commands from the serial port.  

NOTE: If a unit is not identified, click  to provide identification. 

The Testing window contains three tabs: General, Inputs and Outputs. 

6.1.3.1 General Tab 

The General tab enables you to select a specific unit number, query it, and also 

implement Learn settings. You can also define the unit state and download any modified 

data to the unit.  
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6.1.3.2 Inputs Tab 

The Inputs tab enables you to monitor the unit inputs and define a test period for the 

inputs (updated periodically every x seconds). You must select the checkbox to enable 

periodic updates.  
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6.1.3.3 Outputs Tab 

The Outputs tab lists the outputs for the unit. The outputs will be activated when you 

select the corresponding output. The unit ACKs every output change.  

 

6.1.4 Forwarding Data to Wireless Channel 

This function allows the user to forward and receive transparent data (such as text 

messages to/from the Mobile Data Terminal) to/from the wireless channel. The Cellocator 

unit acts as the modem when transparently connecting with cellular products.  
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The green arrow in the lower right corner expands the window to display the Received 

Message pane. 

 

 

6.1.5 Voice Call Management 

This function enables the simulation of voice call management (such as initiating a call, 

receiving a call, rejecting a call, etc.) over the serial port. The Programmer communicates 

with the unit, when hands-free is activated/available. The feature generates the 

appropriate serial string following the command selected. 
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6.1.6 Manufacturing Info Request 

This feature is used for debug purposes. A customer can use this feature to provide the 

Cellocator Customer Support with Production information about the unit. 



 

Cellocator Programmer 

Manual 

 
 

 

Cellocator Programmer Manual                                                                                             Page 39 of 100  

Copyright © 2018 by Pointer Telocation, Ltd. 

 

 

6.1.7 Forwarding AT Command  

This feature provides a transparent interface to the cellular modem, mainly for debug 

purposes. Please note the unit will not allow the use of dial up commands. This feature 

should be used in tandem with Cellocator Support. 
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6.1.8 Platform Manifest 

This feature is used for debug purposes and should be used in tandem with Cellocator 

Support.  

 

6.1.9 Configuring Counters Inputs Settings 

The unit can measure the period of time during which an input is active. Up to two inputs 

can be defined. 
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6.1.10 Custom Commands 

The Custom Command feature enables you to enter a custom command, including an 

appended checksum, as shown in the following window. 

 

6.1.11 Cello Platform Manifest 

The Cello Platform Manifest provides more detailed hardware and software maintenance 

information than the standard Platform Manifest (see above). This feature should be used 

in tandem with Cellocator Support. 
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6.1.12 Configuring Communications and Memory Parameters 

The Configuration window includes four tabs; note that only the Communication tab 

should be used, the other tabs are for use by Cellocator personnel only. 

6.1.12.1 Communication Tab 

This tab enables you to set a variety of communication settings, including the port and 

baud rate, according to the unit type.  

 

6.2 PL Editing 

This section includes the following: 

 Configuring roaming settings, see BELOW 

 Configuring VTrek settings, page 43 

 Authentication table, page 43 

 Navigation options: go up a level, back/forward (see the Toolbar section for further 

information) 

 Display parameters page or memory map (see the Toolbar section for further 

information) 

 Dallas Key Code programming, page 44 

For information about the CAN Editor, see the Working with the CAN Editor section on 

page 46. For information about the Nano Editor, refer to the Working with the Nano Editor 

section on page 80. 

6.2.1 Configuring Roaming Settings 

This feature enables priority to be given to certain providers. You can also define whether 

providers should be banned when roaming is enabled (by selecting 00-Forbidden).   
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6.2.2 Configuring VTrek Settings 

This feature enables the frequency of “time events” to be linearly adjusted to the speed of 

the vehicle. 

 

6.2.3 Authentication Table 

Confirms the reception of incoming message (server to unit) following proper 

authentication. 
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6.2.4 Dallas Key Code Programming 

The Cellocator Programmer facilitates the programming of Dallas Key Codes. Each Dallas 

Key is supplied with a unique code which is written on the base of the button.  

The most effective way to program the key code is to acquire the code using the 

Programmer and the evaluation set, and then to copy and paste it to the appropriate 

window of the Programmer.  

To program the Dallas Key Code perform the following steps: 

1. Verify that the Cellocator unit is connected to the appropriate evaluation kit and 

communication exists with the Cellocator Programmer. 

2. Verify that the Ignition Switch of the vehicle simulator (tester) is turned On. 

3. Touch the Dallas reader on the vehicle simulator with the Dallas button. 

4. Click the Master Status button ( ) on the Programmer tool bar.  

5. Scroll down the Unit’s Status data, where the last detected Dallas number is listed. 

6. Copy the number and close the Master Status window. 

7. In the Security >Dallas folder, select the required Dallas code entry and double-click it. 

 

8. Paste the copied Dallas Code in the Enter Value field and click OK. 

9. Repeat the steps above for the remaining Dallas buttons. 

6.3 PL Management 

This section includes the following: 

 Creating, opening and saving PL files (see the Toolbar section for further information) 

 Including configuration memory content in parameter library (see the Toolbar section 

for further information) 

 Uploading parameters from unit (see the Toolbar section for further information) 
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 Downloading parameters to unit (see the Toolbar section for further information) 

 Downloading and verifying  parameters (see the Toolbar section for further 

information) 
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7 Working with the CAN Editor 

This section provides details of the CAN Editor, which is only relevant for Cello units that 

support the CAN Bus and K-Line interfaces. This section describes the CAN Editor 

functionality for FW versions 33x and newer; the functionality of the CAN Editor for older 

versions is slightly different.  

This section includes the following: 

 Overview, see below 

 Introducing the CAN Editor Window, see below 

 Building the CAN Configuration for a PL, see page 50 

 Building Vehicle Libraries, see page 63 

7.1 Overview 

Using the CAN Editor, you can set up CAN configuration schemes using various CAN 

parameters and operators that will create trigger criteria that enforce events via the unit. 

There are two options to work with the CAN Editor:  

 Build the CAN configuration for a PL (complete with default rules and schema), as 

described on page 50. 

 Build a vehicle library (meaning a library of the relevant parameters required for each 

car model), as described on page 63. 

--------------------------------------------------------------------------------------------------- 

NOTE: All CAN configuration and vehicle library XML files provided by Cellocator from FW 

ver. 36n are encrypted. However, you can still add your own parameters, filters, and 

queries using the CAN Editor tool and include them with the same XML file that includes 

the encrypted fields generated by Cellocator (note that these encrypted fields are grayed 

out in the CAN Editor UI and cannot be edited).  

The added encryption does not impact your use of Cello CANiQ in any way. 

--------------------------------------------------------------------------------------------------- 

7.2 Introducing the CAN Editor Window  

7.2.1 Accessing the CAN Editor 

 To access the CAN editor: 

1. In the Cellocator Programmer window, click  to launch the CAN Editor. 

2. In the displayed message box, click Yes to edit the CAN configuration file of the 

programmed PL, otherwise click No. 

The CAN Editor window is then displayed. See the following sections for a description 

of the CAN Editor window components. 

Note that when the version of your PL is incompatible with the current version of the 

CAN Editor, “Old FW Compatibility Mode” is displayed in the toolbar, as shown below. 

This may result in minor differences to some of the functionality described in this guide. 
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7.2.2 CAN Editor Window Components 

This section describes the various components of the CAN Editor window, as shown below. 

 

7.2.3 Menu Bar 

The Menu options are either intuitive or explained in the table below. 

Menu Option Description 

File Includes the following options: 

 Load/Save configuration 

 Load/Save vehicle library 

 Print report 

 Export diagram to image 

 Exit 

Toolbar

Tabs

Status bar

Menu bar
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Menu Option Description 

Actions Includes the following options: 

 Read from PL 

 Write to PL 

 Supported PIDs query 

 Verify logic 

 Clear vehicle library 

 Clear configuration 

Edit Includes standard UI options of Undo/Redo, Copy, Cut, and Paste. 

View Includes the following options: 

 Optimize diagram layout 

 Show parameters gallery visible 

 Zoom to fit 

 Zoom in / Zoom out 

Help Includes details about the version. 

7.2.4 Toolbar 

The Toolbar options are either intuitive or explained in the table below. 

Icon Description 

 
Read CAN configuration from PL 

 
Write CAN configuration to PL 

 
Undo 

 
Redo 

 
Print diagram view 

 

Optimize diagram layout 

 

Verify logic 

 

Queries supported standard parameters for the 

connected device (when clicked, the Programmer 

displays all relevant parameters in the Custom 

Parameters tab of the CAN Editor) 
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7.2.5 Tabs 

The CAN Editor window has three main tabs: the Diagram View tab, the Table View 

tab, and the Vehicle Library tab. 

The Diagram View tab allows you to define a CAN configuration scheme by building a CAN 

configuration diagram using graphic tools. The CAN configuration scheme defines the 

required CAN parameters, the logic operations activated on these parameters and the 

event generated when the conditions are fulfilled. The Diagram View tab is described in 

the Building the CAN Configuration for a PL section. 

The Table View tab allows you to view and edit the characteristics of each instance of CAN 

parameter, operator or event which are included in the CAN configuration diagram. The 

Table View tab is described in more detail in the Building the CAN Configuration for a PL 

section. 

The Vehicle Library tab allows the definition of non-standard (custom) CAN parameters 

and their properties, and the functionality of CAN Bus characteristics. You can also 

prepare a set of CAN parameters, custom parameters, and K-Line parameters, and save 

them in a library file. The library files generally describe the CAN parameters of certain 

vehicle models and years. The Vehicle Library tab is described in more detail in the 

Building Vehicle Libraries section. 

7.2.6 Status Bar 

 

The Status bar, located at the bottom of the CAN Editor window, provides visual indication 

of the following: 

 Current CAN Editor status, from one of Ready (before you create your configuration 

diagram), Verified OK (indication that your diagram logic is valid), or 

Warnings/Errors (see the warnings and errors in the panel just above the Status 

bar, accessed by clicking the arrow icon on the far left of the status bar, as shown 

below; note that you can also double-click on any warning or error message to jump 

to the relevant parameter or operator in the Diagram View). 

 

 Memory usage; the value indicated (example: 60/1960) will change according to the 

number of non-standard and J1939 parameters used, as well as Operators, as they all 

have some memory volume. The standard parameters have no memory volume and 

will not impact this value. Note that the memory bar to the left of this value provides a 

visual "traffic light" indicator of the current memory usage. 

 The number of parameters currently in use, up to a maximum of 35. 
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 The signature ID of the PL file. Note that because the PL signature is updated upon 

each download, you can ‘lock’ it to prevent a new signature being created (right-click 

on the PL signature and from the popup menu, select Lock). This is especially relevant 

when minimal changes have been applied to the PL file. To revert to the PL signature 

used in the previous session, right-click the PL signature and select Restore. 

 The last performed action; a textual indicator of the last performed action, such as 

Configuration cleared or Errors/warning found. The name of the relevant XML file is also 

displayed in the line below the red text, for example when saving the configuration. 

7.3 Building the CAN Configuration for a PL  

This section describes how to build the CAN configuration for a PL using the CAN Editor 

visual composer tools. These tools help you create a configuration diagram that displays 

all the defined rules and configuration parameters. 

7.3.1 Use Case Scenarios 

The following use case scenarios are the three main ways you build your CAN 

configuration for a PL file. 

 Update an existing PL with an existing configuration file: This scenario is 

relevant when you want to take an existing PL file and update it. Via the Cellocator 

Programmer, access the CAN Editor, and when prompted, click Yes to work on the PL. 

Then load the configuration file for the same PL as described in the section below. 

 Apply a configuration file to an existing PL: This scenario is relevant for creating 

a CAN configuration scheme which is similar to an existing one, and when making a 

number of changes instead of creating the configuration from scratch. After accessing 

the CAN Editor and loading the relevant PL, then load the required configuration file. 

Upon completing your changes, the system will generate two files, the PL and an XML 

file, synched with the same name. 

 Create a CAN configuration from scratch with a library file: This scenario is 

relevant for a PL file with no configuration file. Take a library file associated with the 

required vehicle model and load it in the CAN Editor as described in Defining Custom 

Parameters and Characteristics in the Vehicle Library Tab; the configuration diagram will 

be empty, but this enables you to start with the specific vehicle parameters you need. 

7.3.2 CAN Configuration Output  

When you have completed creating a configuration diagram, the CAN Editor generates 

two outputs: 

 The PL file is updated with the CAN configuration data. 

 An XML file is created (with the same name as the PL file but with an additional .Config 

suffix), which includes all the information regarding the CAN configuration schema. This XML 

file is designed specifically for application developers, as it provides all the necessary 

information regarding the triggered event which can be used as inputs for the SW application. 

In order to ensure that these two outputs hold the same parameters and values, they are 

assigned with the same signature. The signature stored in the PL is shown in the CAN 

Editor window, as shown on page 46.  

The signature stored in the XML file can be reviewed at the top of the file using a regular 

text editor.  
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7.3.3 Loading a CAN Configuration 

When entering the CAN Editor or loading the PL file, there are no names assigned to the 

instances or parameters / operators (for example, in the Table View tab no names will 

be listed), since these are included in the XML configuration file only. In order to work 

correctly, the back office application will require named parameters and operators; 

therefore you will need to load the XML configuration file, which also includes all the 

configuration rules and diagrams. 

 To load a configuration file: 

When accessing the CAN Editor, you will be prompted to reload the CAN information from 

the existing PL.  

 

Click Yes to reload the PL configuration data. If you have changed the CAN configuration 

these changes will be overwritten. If you have just the CAN Editor open, you can click No. 

From the File menu in the CAN Editor window, click Load Configuration to load the 

appropriate configuration file in .XML format. Generally, you have to load a configuration 

file with the same name as the PL file (which can be verified in the PL signature). The 

parameters and operators relevant to that PL file are loaded and available for use in the 

configuration diagram. 

If starting a configuration from scratch, you can take an existing configuration file that is 

similar to your requirements, load it (as described above) and modify as required. For 

example, if you want to create a new configuration file for a Chevrolet 2011 model and 

you have an existing, almost identical Chevrolet 2010 model, first load the 2010 model 

configuration file. 

7.3.4 Querying the vehicle for Standard PIDs 

From version 36v, you can query the device itself for all standard PIDs by clicking ; 

when clicking this toolbar icon, all standard PIDs associated with the vehicle are displayed 

in the CAN Editor (in the Custom Queries and Custom Parameters tabs). 

Once all standard PIDs are loaded from the vehicle, you can continue to edit and manage 

the CAN configuration, as described in the following sections. 

7.3.5 Editing a CAN Configuration  

There are two stages to editing the CAN configuration: 

1. Editing the configuration via the Diagram View tab: this enables you to visually 

edit the configuration file in a visual composer. Refer to the Building CAN 

Configuration Rules via the Diagram View Tab for more information. 
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2. Editing operators and parameters in the Table View tab: in this step you view 

and edit the configuration in table form, and perhaps more importantly, add names to 

the relevant operators and parameters so that they can be used correctly by the CAN 

Editor. Refer to the Modifying the CAN Configuration via the Table View Tab section for 

more information. 

7.3.6 Managing a CAN Configuration File 

This section describes a number of options you have for managing your CAN configuration 

file, including how to complete the editing of a CAN configuration. 

When you have completed editing your configuration file, it must be saved as described in 

the following procedure. 

 To save a CAN configuration: 

From the File menu, select Save Configuration, to save the CAN configuration diagram.  

A warning message is displayed, informing you that the PL signature is no longer updated 

and that you need to write the changes to the PL file. Click Yes if you want to update the 

PL.  The file is saved in XML format to your selected destination. 

In addition, click  on the toolbar to write the CAN configuration diagram to a PL file 

to update the PL with your changes. The memory map in the Cellocator Programmer (or 

OTA Programmer) is updated according to the configuration in the CAN Editor; to update 

the unit you should download the PL with the Cellocator Programmer (or OTA 

Programmer) interface. 

 To clear a CAN configuration diagram: 

To clear the CAN configuration diagram, select Clear Configuration from the Actions 

menu.  

 To export the CAN configuration diagram as an image: 

You can export the CAN configuration diagram to an image; from the File menu, select 

Export Diagram To Image. The file is saved in PNG format.  

 To print a report of the CAN configuration diagram: 

You can also print a report of the CAN configuration diagram, by selecting Print from the 

File menu. The file is generated in PDF format. 

7.3.7 Building CAN Configuration Rules via the Diagram View Tab 

7.3.7.1 Overview of the Diagram View Tab 

The Diagram View tab is the visual composer that enables you to build a configuration 

diagram from operators and parameters selected in the Components Set pane and Gallery 

(see also the Component Set Pane and Gallery sections below). 

A configuration diagram is a flow diagram consisting of filtering, triggering, and reporting 

elements. Note that in each configuration diagram, which flows from left to right, there 

must be at least one parameter (either CANBUS/J1939, Custom, or K-Line, shown in the 

workspace in a light green square), one Operator (shown in the workspace with an orange 

square), and one “Generate Event” Operator (shown in the workspace with a yellow 

square).  



 

Cellocator Programmer 

Manual 

 
 

 

Cellocator Programmer Manual                                                                                             Page 53 of 100  

Copyright © 2018 by Pointer Telocation, Ltd. 

 

For details on how to build a configuration diagram, refer to page 54. 

 

 

In the image above, the Operators component set is selected; the Gallery displays all the 

relevant operators and one basic CAN rule is presented in the workspace. 

Note that there are a number of parameter types to choose from (select the relevant 

option from the Component Set pane column to display the available parameters). See 

the following Component Set Pane section. 

7.3.7.2 Component Set Pane 

The Component Set pane lists the various component sets available for use in the 

configuration diagram: Custom Parameters, CANBUS/J1939, K-Line Parameters, 

System Parameters, Operators and Container. When you click on the relevant option, 

the parameters for that option are displayed in the Gallery. 

Note that the Container option enables you to combine a number of variables and operators 

together in a single structure. This can be especially useful when you have a large number 

of parameters and operators in your diagram as the Container can be collapsed as required, 

including all the parameters and operators within the Container (to expand/collapse the 

Container, click on the arrow icon in the top right corner of the Container). 

7.3.7.3 Gallery 

The Gallery lists the available parameters of the selected component set. For example, if 

CANBUS/J1939 was selected in the Component Set pane, the Gallery displays only the 

CANBUS / J1939 parameters. 

Gallery

Component 

Set pane

Workspace Zoom tool

Parameter

Filter
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Note that the Gallery pane name changes to reflect the selected component set. Note that 

you can also collapse the left navigation panes by clicking the arrow icon to the right of 

the Gallery pane title, as shown below. This helps maximize the workspace available for 

building your CAN configuration diagram. 

 

7.3.7.4 Workspace 

The workspace is where you build the CAN configuration diagram (subsequently it is only 

displayed in the Diagram View tab). 

7.3.7.5 Parameter Filter 

Use the parameter filter to locate a specific parameter in the gallery. Note that the filter 

applies to only the selected component set selected from the Component Set pane.  

7.3.7.6 Zoom Tool 

To zoom in on the diagram you have built, click  to "zoom to fit", use the magnifying 

glass located in the lower right corner of the window, or use the scroll button on your 

mouse. An additional smaller navigation screen is displayed in the lower right corner, as 

shown below: 

 

You can also click  to automatically optimize the diagram layout. 

The Zoom tool is only available in the Diagram View tab. 

7.3.8 Editing Configuration Rules in the Diagram View Tab 

The following procedure describes how to build a basic CAN configuration diagram. 

When editing an existing PL, the PL comes with a defined CAN configuration, which should 

be loaded (as described on page 51). To ensure the configuration file is the correct file, 

verify the PL signature is correct in the status bar. 
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--------------------------------------------------------------------------------------------------- 

NOTE: Throughout the process of building a CAN configuration diagram, there may be 

errors and warnings displayed in the status bar; please pay attention to these errors and 

warnings as they will assist you in building an operational configuration diagram.  

--------------------------------------------------------------------------------------------------- 

 To edit configuration rules in the Diagram View tab: 

1. In the Diagram View tab, select the required set of parameters from the Component 

Set pane. The parameters specific to that set are displayed in the Gallery. 

2. Drag the relevant parameters from the Gallery to the workspace. 

------------------------------------------------------------------------------------------------ 

NOTE: Parameters cannot be edited in the workspace, but can be moved or deleted by 

selecting them with your mouse. Define operator/parameter names in the Table View 

tab, as described on page 59.  

------------------------------------------------------------------------------------------------ 

In the following example, the FuelLevel parameter has been selected from the Custom 

Parameters Gallery and is displayed in the workspace. 

 

3. If required, after querying for standard PIDs you can change the periodic Polling Time 

(in seconds) for the selected parameter(s) by clicking the Vehicle Library tab and 

then the Custom Queries sub-tab. In the Polling Times column, click on the value to 

edit it. 

4. In the Component Set pane, click on Operators. The available Operators are 

displayed in the Gallery.  
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5. Drag the required Operator from the list of available Operators and place it next to the 

parameters you selected in Step 2 in the workspace. In the example below, the In/Out 

Range Operator has been selected. 

You can use the same Operator more than once; in this case, the ID assigned to the 

Operator will increase sequentially, depending on the number of times used. 

 

6. (Optional) To edit an Operator's properties, click  in the lower right-corner of the 

Operator (or double-click on the Operator itself). The Properties dialog for the specific 

Operator is displayed. 

In the Properties dialog box for each Operator you can add a description in the 

Description field, which will also be displayed in your CAN configuration diagram. This 

Description field is especially relevant for the Generate Event Operator, which is seen 

on the server side and gives backend personnel a better indication of events. 

After entering a Description, or modifying any of the available settings, close the 

Properties dialog to save your changes. Note that these changes are not applied to the 

PL file itself; see page 47 for details on how to save the PL file configuration. In 

addition, the Help option at the bottom of the Properties dialog (as indicated below - 

click to expand/collapse) provides additional information about the Operator. 
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7. To connect a parameter with the Operator, click on the parameter box to display the 

Connect output connector (on the right side of the parameter box, as shown below). 

Click on the Connect output connector and drag the connector arrow to the input 

connector of the Operator (which should automatically be displayed when dragging the 

connector towards it).  

 

8. From the list of displayed Operators, drag the Generate Event Operator to the 

workspace. To edit the Generate Event properties to ensure its relevancy to your 

diagram, click  in the lower right-corner of the Operator (or double-click on the 

Operator itself). The Properties dialog is displayed via which you can edit the relevant 

properties (see Step 6 for further information). 

9. To connect the Operator you selected in Step 6 with the Generate Event Operator, 

click on the Operator box to display the Connect output connector (on the right side of 

the Operator box). Click on the Connect output connector and drag the connector 

arrow to the input connector of the Generate Event Operator (which should 

automatically be displayed when dragging the connector towards it). 
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------------------------------------------------------------------------------------------------ 

TIP: You can verify that the variables and Operators are correctly connected by 

opening the Properties dialog for the relevant Operator. If connected, the value of the 

variable should be displayed. For example, if you are connecting the VehicleSpeed 

variable with the In/Out Range Operator, the value in the Properties dialog box will 

display Km/h (instead of RAW Data) once connected. 

------------------------------------------------------------------------------------------------ 

10. Repeat as required (you can use the same parameter more than once). 

------------------------------------------------------------------------------------------------ 

TIP: To zoom in on the diagram you have built, click  to "zoom to fit" or  to 

automatically optimize the diagram layout. See the CAN Editor Window Components 

section for further information.   

------------------------------------------------------------------------------------------------ 
 

------------------------------------------------------------------------------------------------ 

TIP: To view the parameters and operators in the diagram you have built in the Table 

View tab, press Alt + Double-click to automatically jump to the selected parameter or 

operator in the Table View. To return to the diagram layout, press Alt + Double-click 

on the parameter or operator.   

------------------------------------------------------------------------------------------------ 

11. To verify the flow validity of your configuration diagram, click . A list of any errors 

and/or warnings is shown in the status bar at the bottom of the CAN Editor window. 

See the Status Bar section on page 49 for further information.  

------------------------------------------------------------------------------------------------ 

NOTE: You can see a “dump” list of all the variables in your current configuration 

diagram by accessing the Properties dialog of the Generate Event Operator. In the 

Message descriptor section a list of variables and parameters is displayed (these will 

be seen on the server side), from which you can remove and add as required. 

------------------------------------------------------------------------------------------------ 

12. Save your configuration, as described on page 52. 
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7.3.9 Modifying the CAN Configuration via the Table View Tab 

As required, you can also edit and name the CAN configuration components in table 

format via the Table View tab. This is an important part of the CAN configuration process, 

because without defined names (which you cannot define in the Diagram View tab) 

integrators will not be able to identify the parameters and activate the required logic.  

The Table View tab provides a data format view of what is displayed in the Diagram View 

tab, only displaying parameters and Operators that have been used in the Diagram View 

tab. The tab is divided into two sub-tabs, in which you can see and edit the hexadecimal 

values and raw data for Operators and Parameter Descriptors.  

In addition, the Table View tab presents each instance of the parameters and operators 

according to the number of times they are used in the configuration diagram. 

 To work with the CAN configuration in table format: 

1. In the Table View tab, click on the relevant sub-tab according to the values and data 

you want to edit/view (Operators or Parameter Descriptors). 

A list of the currently used Operators / parameters is displayed. 

2. Define values and data as relevant.  

Note that any changes you make in each sub-tab will be reflected automatically in the 

CAN configuration diagram. 

3. Save the file, as and when required, as described on page 52. 

--------------------------------------------------------------------------------------------------- 

TIP: To view the parameters and operators in the configuration diagram (in the Diagram 

View tab) you have built, press Alt + Double-click to automatically jump to the selected 

parameter or operator in the diagram layout. Note that to return to the Table View tab, 

press Alt + Double-click on the parameter or operator.   

--------------------------------------------------------------------------------------------------- 

The following sections describe the two tabs and the fields in each tab. 

7.3.9.1 The Operators Tab  
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The operators are used to filter the parameters reported by the CAN Bus, allowing the 

generating of events only when all event conditions are fulfilled. The operator fields are 

listed in the following table. 

Field Description Editable 

 (click to 

expand) 

Displays the raw data of the operator 

properties, allowing the user to edit the 

values. It is advised to edit the logical 

values of the properties via the Diagram 

View tab. 

Yes 

 

 

Name Name of the operator. Yes 

Description Description of the operator as defined by 

the user. 

Yes 

Type The predefined Operator type provided 

by the CAN Editor.  

No 

ID Numerical number allocated for the 

operator instance by the CAN Editor. 

No 

Sources The names of the actual sources 

(parameters or operators) of the 

operator's inputs. 

No 

Raw Data Displays the raw data values which 

represents the operator in the PL. Note 

you can click on the arrow icon (next to 

the filter icon) to expand the column to 

display all the information.  

No 

Address The operator address in the PL. No 

Length The length of the operator raw data. No 
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7.3.9.2 The Parameter Descriptors Tab  

 

The Parameter Descriptors tab presents information regarding the Custom Parameters 

defined in the Vehicle Library tab. The Parameter Descriptor fields are listed in the 

following table. Note that if you modify values in this tab, the parameters will also be 

modified in the vehicle library definition for that specific vehicle model. Therefore, it is 

only recommended to modify the Name field; all other parameters should be modified in 

the Vehicle Library tab only. 

--------------------------------------------------------------------------------------------------- 

NOTE: Parameters included with the XML files of FW ver. 36n and above, provided by 

Cellocator, come encrypted, and the following fields will be grayed out and cannot be 

edited: Filter, Arbitration ID, Response mode (SID), PID length, PID1, PID2, Start bit, 

Data length (bits), Little Endean, and Consider PGN only.  

You can still add your own parameters using the CAN Editor and include them with the 

same XML file that includes the encrypted parameters generated by Cellocator.  

--------------------------------------------------------------------------------------------------- 

Field Description Editable 

# The operator ID which these parameters are 

related to. 

No 

 

Name Parameter name defined by the user. Yes 

Parameter ID The ID allocated to the parameter by the 

CAN Editor. 

No 

Filter Set the required filter name from the 

existing filters. 

Yes 

Arbitration ID The application automatically displays the 

Arbitration IDs as defined in the vehicle 

library. 

Yes 

Trg Currently not in use (infrastructure). No 

Trg Addr Required to identify the receiving module on 

the K-Line bus (or unit).   

Yes 
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Field Description Editable 

Src Enables filtering of parameters from a 

specific sending module on the K-Line bus. 

When Src is not selected, the related 

parameter will be accepted from any sending 

module (ignoring the specific source 

address, if indicated). 

Yes 

Src Addr Required to identify a specific sending 

module on the K-Line bus.   

Yes 

Payload Length The parameter payload (data) length. Yes 

Response mode 

(SID) 

The SID related to the parameters according 

to the standard (all parameters should be 

associated with the same SID). 

Yes 

PID length The parameter ID length. Yes 

PID1 The PID hex code as defined in the standard. Yes 

PID2 The PID hex code as defined in the standard. Yes 

Start bit The location in the received information in 

which the parameter starts. 

Yes 

Data length (bits) The parameter data length. Yes 

Little Endean Set Little or Big Endean. Select the checkbox 

to ensure Little Endean is applied. 

Yes 

Consider PGN 

only 

When selected, considers only the 18 bits of 

PGN from 29 bits of identifier structure. 

Yes 

Raw Data The parameter raw data presentation in the 

PL. 

No 

Address The address of the parameter raw data in 

the PL. 

No 

Function Set the fleet function which will use the 

parameter as input. Select from Not 

assigned, Speed, RPM, Fuel Tank Level, 

Fuel Consumption Direct, Odometer, 

Fuel Consumption Estimation (one of 

FR\MAF, FL, RPMFIQ RPM, or RPMFIQ 

FIQ) DTCO (one of Work States, Driver 1 

States, Driver 2 States, Tachograph 

Status, or Tachograph Vehicle Speed), or 

Fuel Consumption Estimation (one of 

RPMIMAPIAT RPM, RPMIMAPIAT IMAP, 

RPMIMAPIAT IAT, MAFO2 MAF, or 

MAFO2 O2). 
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Field Description Editable 

Multiplier The signed number (b) in which the unit will 

multiply the received value (x) to accomplish 

the equation y=a+x*b/c. 

Yes 

Divider The signed number (c) in which the unit will 

divide the received value (x) to accomplish 

the equation y=a+x*b/c  

Yes 

Coefficient This value replaces the Multiplier/Divider 

value. For example, instead of b/c, 2.7 will 

be displayed. 

Yes 

Offset The signed number (a) which will be added 

to the received value (x) to accomplish the 

equation y=a+x*b/c. 

Yes 

Units The measurement units as defined by the 

user. 

Yes 

Decimal Places Define the decimal representation of the 

result (y). 

Yes 

7.4 Building Vehicle Libraries  

A vehicle library includes a set of parameters only, without the operators and 

configuration diagram information, and is stored as an XML file, typically with a 

.VehicleLibrary extension. Generally, vehicle libraries can be used to build a set of 

parameters per vehicle model, which can be used as input for any CAN configuration 

required for that specific vehicle model.  

The CAN Editor enables you to save the parameters set of an existing configuration file or 

vehicle library file to a new or existing vehicle library file, to edit an existing vehicle library 

file, and to load a vehicle library file as the basis for a new configuration file when starting 

from scratch.  

Cellocator provides a default vehicle library file, which includes the full set of FMS 

parameters, as part of the Cello-CANiQ release package.  

Note that parameters can be copied from one XML file to another one using a standard 

XML editor.  

--------------------------------------------------------------------------------------------------- 

NOTE: Parameters included with the XML files of FW ver. 36n and above, provided by 

Cellocator, come encrypted, meaning they are grayed out and cannot be modified. 

However, you can still add your own parameters using the CAN Editor and include them 

with the same XML files that include the encrypted parameters generated by Cellocator.  

Note that you can also cut, copy and paste the values in many of the parameter fields. 

--------------------------------------------------------------------------------------------------- 
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7.4.1 Use Case Scenarios 

The following use case scenarios are the four main ways you build a vehicle library file. 

 Use library files provided by Cellocator: Cellocator maintains a database of library 

files. The specific vehicle models and the supported parameters are defined in the 

Supported Vehicles Database, which can be downloaded from the Cellocator 

website (the Cello-CANiQ page). This is a good option to use as a base for your 

vehicle library file. Load the file and modify according to your requirements (as 

described later in this section).  

 Load an existing library file: if you have an existing library file that has a number 

of specific parameters you want to use in a new library file, load the existing file, 

make your changes (as described later in this section), and then save it as a new file. 

 Load a configuration file and save it as a library file: If you have a configuration 

file that you want to use as the base for your library file, load the relevant XML file 

and save it as a library file. 

 Start from scratch: To start a vehicle library file from scratch, load the default PL file 

provided in the release package in the Cellocator Programmer, enter the CAN Editor 

and then access the Vehicle Library tab to configure the relevant parameters. 

7.4.2 Supported CAN Parameters 

The CAN Editor supports configuration parameters based on either OBDII and/ or J1939 

standards. You can program the CAN editor to support either OBDII and/ or J1939 

standard and / or non-standard parameters as appropriate to the library of a specific 

vehicle model. These parameters should be defined in the Vehicle Library tab, as 

described later in this section. 

7.4.2.1 Defining Custom Parameters and Characteristics in the Vehicle 

Library Tab 

This section describes how to manage and edit custom parameters in the Vehicle Library 

tab. This tab enables you to view, add, modify or delete custom parameters and to save 

them to an existing parameter set of a vehicle library or specific configuration file.  

The Vehicle Library tab includes the following sub tabs: Filters, CANBUS/J1939 

Parameters, Custom Parameters, Custom Queries, K-Line Parameters, K-Line 

Queries, Interfaces Settings, and Information.  

 

Note the following: 

 When building a vehicle library, the first step is to define the CAN Bus settings, as 

described on page 66. 

 The K-Line Parameters and K-Line Queries tabs are only displayed if the device 

supports K-Line parameters. 

 Each J1939 parameter must be associated with an existing filter, and consequently 

that filter must be programmed before the parameter programming. 

http://www.cellocator.com/?s2member_file_download=cellofamily/Cello-CANiQ/Supported%20Vehicels%20Database.xlsm
http://www.cellocator.com/knowledgebase/cellocator-cellofamily/cello-caniq/
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 Each custom parameter must be associated with the appropriate query, and 

consequently that query must be defined before the parameter programming (in the 

Custom Parameters tab). 

 Each custom query (user defined type) must be associated with an existing filter, and 

consequently that filter must be defined before the query programming (in the Custom 

Parameters tab). 

Adding or editing custom parameters requires a deep understanding of the appropriate 

standard on one hand and the unit behavior on the other hand. It is strongly 

recommended to contact Cellocator Customer Support for assistance. 

 To load a vehicle library file: 

1. Open the CAN Editor, and in the displayed message box prompting you to reload the 

CAN information from the existing PL, click No. 

2. From the File menu, click Load Vehicle Library. The following message is displayed. 

 

3. Click OK and then browse for an existing vehicle library file in XML format (with a 

*.VehicleLibrary suffix). The parameters and Operators relevant to that file are loaded 

and available for use in the configuration diagram 

 To add or modify custom parameters or filters or queries: 

1. In the Vehicle Library tab, click on the relevant sub-tab (Filters, CANBUS/J1939 

Parameters, K-Line Parameters, K-Line Queries, Custom Parameters, or 

Custom Queries).  

2. Click Add Filter, Add Parameter, or Add Query, and define the relevant fields for 

the new filter/parameter/query (if modifying an existing parameter or filter, refer to 

the following sections that describe each of the available parameters and filters).  

For example, when adding a Filter, in the Filters tab click Add Filter and then define 

the following: 

 Title (or name) for the Filter 

 Select the Enabled checkbox to ensure the Filter is enabled and available for selection 

 The Arbitration ID value as defined in the PGN 

 Bits Selection Mask value (select from Exact match, Ignore last 2 bits of 

filter, Ignore last 3 bits of filter, or Ignore last 4 bits of filter)  

 FrameFormat (select from Can11bit or Can29bit) 

 Arbitration IDs automatically displays the selected Arbitration IDs (you cannot 
define it), according to the value you selected in the Bits Selection Mask column. 

3. From the File menu, select Save Configuration to save the modified CAN configuration 

diagram; for vehicle libraries select Save Vehicle Library from the File menu. Note 

that when you modify a vehicle library file it should be saved with the relevant name. 
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 To delete a custom parameter, filter, or query: 

1. Select the relevant filter / parameter / query by clicking in the left column (use your 
keyboard to select multiple filters / parameters). 

2. Click Delete Filter, Delete Parameter, or Delete Query. 

3. In the displayed confirmation message, click Yes. If the parameter is currently in use, 
you will be informed that you cannot delete it. 

------------------------------------------------------------------------------------------------ 

NOTE: You cannot delete parameters, filters, or queries that are in use (assigned in a 

configuration diagram) or bound to another (such as a filter used by a parameter). 

------------------------------------------------------------------------------------------------ 

7.4.3 The Interfaces Settings Tab  

 

The Interfaces Settings tab allows you to define the following CAN Bus and K-Line 

characteristics: 

 CAN BUS settings: 

 CAN Operational Modes: Select from RX Only Mode, Disable CAN 1, Full OBD 

RX & TX mode, or Special RX & TX mode.  

 CAN Bus Format: Select from 11 Bits or 29 Bits. 

 CAN Bus Rate: Select from the relevant rate available. 

 J1939 Flash Lamp Detection: Select the checkbox to enable a search for Bus 

detection statuses, which are sent to the server as events. 

 OBDII MIL Detection: Select the checkbox to enable a query to search the Bus, 

which receives status updates and reports on MIL changes to the server. 

 DTC Process Control: Select the checkbox to enable DTC Process Control. In this 

case, the unit will use DTC reports from the CAN bus.  

 Enable OBD BUS as VIN source: Select the checkbox to enable the OBD BUS as 

a VIN source. In this case, the unit will query and use the VIN from the CAN bus.  
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 K-Line BUS settings: 

 K-Line Operational Modes: Select from Disable K-Line, Reserved, ISO 9141-

2- / 14230-2 Slow Init, ISO 14230-2 Fast Init, or Automatic Init Type 

Selection. 

 K-Line MIL Detection: Select the checkbox to enable a query to search the Bus, 

which receives status updates and reports on MIL changes to the server. 

 K-Line DTC Process Control: Select the checkbox to enable DTC Process 

Control. In this case, the unit will use DTC reports from the K-Line bus. 

 Enable K-Line as VIN source: Select the checkbox to enable the K-Line BUS as 

a VIN source. In this case, the unit will query and use the VIN from the CAN bus 

--------------------------------------------------------------------------------------------------- 

NOTE: When selecting any of the MIL Detection, DTC Process Control, or Enable as a VIN 

source checkboxes, be aware that selecting the option under the CAN BUS settings 

section will automatically disable the corresponding option in the K-Line BUS settings 

section, and vice versa. 

--------------------------------------------------------------------------------------------------- 

7.4.4 The Filters Tab 

 

The Filters tab allows you to view and define the properties of the filters required for the 

definition of all parameters. The filter is required to isolate the bits of the required 

parameter from the information received from the CAN bus. The Filter fields are described 

in the following table. 

--------------------------------------------------------------------------------------------------- 

NOTE: Fields grayed out in the Filters tab are encrypted parameters and cannot be 

edited. 

--------------------------------------------------------------------------------------------------- 

Field Description Editable 

Title Name of the filter. Yes 

Enabled Select the checkbox to enable the filter. Yes 

Arbitration ID The application automatically displays the 

Arbitration IDs according to the value you 

selected in the Bits Selection Mask column. 

Yes 
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Field Description Editable 

Bits Selection 

Mask ID 

Select from Exact match, Ignore last 2 bits of 

filter, Ignore last 3 bits of filter or Ignore 

last 4 bits of filter. 

Yes 

FrameFormat Set the expected CAN frame format Can11bit or 

Can29bit. 

Yes 

Arbitration 

IDs 

The application automatically Displays the 

Arbitration IDs according to the value you 

selected in the Bits Selection Mask column. 

No 

7.4.5 The CANBUS/J1939 Parameters Tab  

 

The CANBUS/J1939 Parameters tab allows you to view and define the properties of the 

custom CAN Bus and J1939 parameters. The parameter fields are listed in the following 

table. 

--------------------------------------------------------------------------------------------------- 

NOTE: Fields grayed out in the CANBUS/J1939 Parameters tab are encrypted and cannot 

be edited. 

--------------------------------------------------------------------------------------------------- 

Note that in this tab an additional table of rows for each of the 8 bytes of the CAN frame is 

displayed at the bottom of the tab. The top row indicates what the CAN Editor and 

Cellocator products use for the CAN BUS frame presentation (shown in line A in the above 

image), while the second row shows the CAN BUS frame presentation that complies with a 

measuring device (Vehicle Spy) supporting the CAN Bus interface (shown in line B above).  

The relevant bits location of the required parameter are automatically highlighted in green 

when you define the start bits and data length, as described in the following table and 

shown in the image above.  

B 

A 
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Field Description Editable 

Image  When initially creating a CAN Bus or J1939 

parameter, the default icon is displayed. To 

change this to something more relevant for the 

parameter, click to the right of the icon and 

select the relevant image from the displayed 

dropdown list of images. 

 

Alternatively, you can right-click on the image 

icon and click Select external image. This 

option enables you to select any external 

image, which will be compressed automatically. 

You can also use a URL as the link to an image, 

which should be in PNG/BMP/JPG format. Note 

that as the image is not stored on your 

computer, the URL should be a static address.  

Yes 

Title Name of the parameter. Yes 

Parameter ID The associated parameter ID defined by the 

CAN Editor. 

No 

Filter Set the required filter name from the existing 

filters. 

Yes 

Arbitration ID The application automatically displays the 

Arbitration IDs according to the Arbitration 

group you selected in the Filters tab. 

Yes 

Data length 

(bits) 

The parameter data length. Yes  

Start bit The location in the received information in 

which the parameter starts. 

Yes 

Start bit 

Vehicle Spy 

The location in the received information in 

which the parameter starts in the Vehicle Spy 

CAN Bus frame presentation. 

Yes 

Little Endean Set Little or Big Endean. Select the checkbox to 

ensure Little Endean is applied. 

Yes 
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Field Description Editable 

Consider PGN 

only 

When selected, considers only the 18 bits of 

PGN from 29 bits of identifier structure. 

Yes 

Function Set the fleet function which will use the 

parameter as input. Select from Not assigned, 

Speed, RPM, Fuel Tank Level, Fuel 

Consumption Direct, Odometer, Fuel 

Consumption Estimation (one of FR\MAF, 

FL, RPMFIQ RPM, or RPMFIQ FIQ) DTCO 

(one of Work States, Driver 1 States, Driver 

2 States, Tachograph Status, or 

Tachograph Vehicle Speed), or Fuel 

Consumption Estimation (one of 

RPMIMAPIAT RPM, RPMIMAPIAT IMAP, 

RPMIMAPIAT IAT, MAFO2 MAF, or MAFO2 

O2). 

Yes 

Multiplier The signed number (b) in which the unit will 

multiply the received value (x) to accomplish 

the equation y=a+x*b/c. 

Yes 

Divider The signed number (c) in which the unit will 

divide the received value (x) to accomplish the 

equation y=a+x*b/c. 

Yes 

Coefficient This value replaces the Multiplier/Divider value. 

For example, instead of b/c, 2.7 will be 

displayed. 

Yes 

Offset The signed number (a) which will be added to 

the received value (x) to accomplish the 

equation y=a+x*b/c 

Yes 

Units The measurement units as defined by the user. Yes 

Decimal 

Places 

Define the decimal representation of the result 

(y). 

Yes 
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7.4.6 The Custom Parameters Tab  

 

The Custom Parameters tab allows you to view and define the properties of custom 

parameters. The Parameter fields are listed in the table below. 

--------------------------------------------------------------------------------------------------- 

NOTE: Fields grayed out in the Custom Parameters tab (as shown above) are encrypted 

and cannot be edited. 

--------------------------------------------------------------------------------------------------- 

Note that in this tab an additional table of rows describing the location of the parameter in 

the CAN frame is displayed at the bottom of the tab, as described in the CANBUS/J1939 

Parameters Tab section on page 68.  
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Field Description Editable 

Image When initially creating a custom parameter, the 

default icon is displayed. To change this to 

something more relevant for the parameter, click to 

the right of the icon and select the relevant image 

from the displayed dropdown list of images. 

 

Alternatively, you can right-click on the image icon 

and click Select external image. This option 

enables you to select any external image, which 

will be compressed automatically. You can also use 

a URL as the link to an image, which should be in 

PNG/BMP/JPG format. Note that as the image is not 

stored on your computer, the URL should be a 

static address.  

Yes 

Title Name of the parameter defined by the user. Yes 

Parameter ID The associated parameter ID defined by the CAN 

Editor. 

No 

Filter Select from one of the available Filters (as defined 

in the Filters tab).  

Yes 

Arbitration ID The application automatically displays the 

Arbitration IDs according to the Arbitration group 

you selected in the Filters tab. 

Yes 

Response 

mode (SID) 

The SID related to the parameters according to the 

standard (all parameters should be associated with 

the same SID). 

Yes 

PID length The parameter ID length. Yes 

PID1 The PID hex code as defined in the standard. Yes 

PID2 The PID hex code as defined in the standard. Yes 

Data length 

(bits) 

The parameter data length. Yes 
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Field Description Editable 

Start bit The location in the received information in which 

the parameter starts. 

Yes 

Start bit 

Vehicle Spy 

The location in the received information in which 

the parameter starts in the Vehicle Spy CAN Bus 

frame presentation. 

Yes 

Little Endean Set Little or Big Endean. Select the checkbox to 

ensure Little Endean is applied. 

Yes 

Consider PGN 

only 

When selected, considers only the 18 bits of PGN 

from 29 bits of identifier structure. 

Yes 

Function Set the fleet function which will use the parameter 

as input. Select from NotAssigned, Speed, RPM, 

FuelTankLevel, FuelConsumption Direct, 

Odometer, Fuel Consumption Estimation (one 

of FR\MAF, FL, RPMFIQ RPM, or RPMFIQ FIQ), 

DTCO (one of Work States, Driver 1 States, 

Driver 2 States, Tachograph Status, or 

Tachograph Vehicle Speed) or Fuel 

Consumption Estimation (one of RPMIMAPIAT 

RPM, RPMIMAPIAT IMAP, RPMIMAPIAT IAT, 

MAFO2 MAF, or MAFO2 O2). 

Yes 

Multiplier The signed number (b) in which the unit will 

multiply the received value (x) to accomplish the 

equation y=a+x*b/c. 

Yes 

Divider The signed number (c) in which the unit will divide 

the received value (x) to accomplish the equation 

y=a+x*b/c. 

Yes 

Coefficient This value replaces the Multiplier/Divider value. For 

example, instead of b/c, 2.7 will be displayed. 

Yes 

Offset The signed number (a) which will be added to the 

received value (x) to accomplish the equation 

y=a+x*b/c. 

Yes 

Units The measurement units as defined by the user. Yes 

Decimal 

Places 

Define the decimal representation of the result (y). Yes 
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7.4.7 The Custom Queries Tab  

 

The Custom Queries tab allows you to view and define up to 16 queries which are not 

included in the set of queries built into the unit.  

The query fields are listed in the table below. 

Field Description Editable 

Active Select the checkbox to ensure the query is active. Yes 

Title Name of the query. Yes 

Header 

Format 

Define the frame format either as defined in the PL 

(Global) 11 bit (Can11bit), or 29 bit (Can29bit). 

Yes 

DLC Define the Data Length Code which is the number of 

bytes the query data is comprised of. 
Yes 

Polling Time The periodic Polling Time (in seconds). Yes 

Query 

Response 

Timeout 

The expected response time of the CAN bus to the 

query. Should not exceed 300 msec. 

Yes 

Arbitration ID The application automatically displays the Arbitration 

IDs according to the Arbitration group you selected 

in the Filters tab. 

Yes 

Number of 

additional 

data bytes 

The number of bytes for the parameters, to be 

reported by the CAN bus, as defined in the standard. 

Yes 

Mode The SID related to the parameters according to the 

standard (all parameters should be associated with 

the same SID). 

Yes 
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Field Description Editable 

PID1 The PID hex code as defined in the standard. Yes 

PID2 The PID hex code as defined in the standard. Yes 

Query Data Define the query data. The number of bytes is 

defined in the Number of additional data bytes 

column. 

Yes 

Data0 – Data7 When in RX Only Mode (defined in the Interfaces 

Settings tab), additional Data columns (Data0 – 

Data7) are displayed. These columns provide a more 

advanced view that shows query data per bit. 

 

 

The grayed out fields are for encrypted queries, 

which come by default with FW ver. 36n and above. 

These encrypted fields cannot be edited. 

Yes 

7.4.8 The K-Line Parameters Tab  

 

The K-Line Parameters tab allows you to view and define the properties of K-Line 

parameters. The parameter fields are listed in the table below. 

----------------------------------------------------------------------------------------------------- 

NOTE: Fields grayed out in the K-Line Parameters tab are encrypted and cannot be edited. 

----------------------------------------------------------------------------------------------------- 

Note that in this tab an additional table of rows describing the location of the parameter in 

the CAN frame is displayed at the bottom of the tab, as described in the CANBUS/J1939 

Parameters Tab section on page 68.  
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Field Description Editable 

Image When initially creating a K-Line parameter, the 

default green K-Line icon is displayed. To change 

this to something more relevant for the parameter, 

click to the right of the icon and select the relevant 

image from the displayed dropdown list of images. 

 

Alternatively, you can right-click on the image icon 

and click Select external image. This option 

enables you to select any external image, which 

will be compressed automatically. You can also use 

a URL as the link to an image, which should be in 

PNG/BMP/JPG format. Note that as the image is not 

stored on your computer, the URL should be a 

static address.  

Yes 

Title Name of the parameter defined by the user. Yes 

Parameter ID The associated parameter ID defined by the CAN 

Editor. 

No 

Trg Currently not in use (infrastructure). No 

Trg Addr Required to identify the receiving module on the K-

Line bus (or unit).   

Yes 

Src Enables filtering of parameters from a specific 

sending module on the K-Line bus. When Src is not 

selected, the related parameter will be accepted 

from any sending module (ignoring the specific 

source address, if indicated). 

Yes 

Src Addr Required to identify a specific sending module on 

the K-Line bus.   

Yes 

Payload 

Length 

The parameter payload (data) length. Yes 

Response 

mode (SID) 

The SID related to the parameters according to the 

standard (all parameters should be associated with 

the same SID). 

Yes 

PID length The parameter ID length. Yes 
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Field Description Editable 

PID1 The PID hex code as defined in the standard. Yes 

PID2 The PID hex code as defined in the standard. Yes 

Data length 

(bits) 

The parameter data length. Yes 

Start bit The location in the received information in which 

the parameter starts. 

Yes 

Start bit 

Vehicle Spy 

The location in the received information in which 

the parameter starts in the Vehicle Spy CAN Bus 

frame presentation. 

Yes 

Little Endean Set Little or Big Endean. Select the checkbox to 

ensure Little Endean is applied. 

Yes 

Consider PGN 

only 

When selected, considers only the 18 bits of PGN 

from 29 bits of identifier structure. 

Yes 

Function Set the fleet function which will use the parameter 

as input. Select from NotAssigned, Speed, RPM, 

FuelTankLevel, FuelConsumption Direct, 

Odometer, Fuel Consumption Estimation (one 

of FR\MAF, FL, RPMFIQ RPM, or RPMFIQ FIQ), 

DTCO (one of Work States, Driver 1 States, 

Driver 2 States, Tachograph Status, or 

Tachograph Vehicle Speed) or Fuel 

Consumption Estimation (one of RPMIMAPIAT 

RPM, RPMIMAPIAT IMAP, RPMIMAPIAT IAT, 

MAFO2 MAF, or MAFO2 O2). 

Yes 

Multiplier The signed number (b) in which the unit will 

multiply the received value (x) to accomplish the 

equation y=a+x*b/c. 

Yes 

Divider The signed number (c) in which the unit will divide 

the received value (x) to accomplish the equation 

y=a+x*b/c. 

Yes 

Coefficient This value replaces the Multiplier/Divider value. For 

example, instead of b/c, 2.7 will be displayed. 

Yes 

Offset The signed number (a) which will be added to the 

received value (x) to accomplish the equation 

y=a+x*b/c. 

Yes 

Units The measurement units as defined by the user. Yes 

Decimal 

Places 

Define the decimal representation of the result (y). Yes 
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7.4.9 The K-Line Queries Tab  

 

The K-Line Queries tab allows you to view and define up to 16 queries which are not 

included in the set of queries built into the unit.  

The query fields are listed in the table below. 

Field Description Editable 

Active Select the checkbox to ensure the query is active. Yes 

Title Name of the query. Yes 

Polling Time The periodic Polling Time (in seconds). Yes 

Query 

Response 

Timeout 

The expected response time of the CAN bus to the 

query. Should not exceed 300 msec. 

Yes 

Format A constant which is defined by the K-Line protocol. Yes 

Trg Addr Required to identify the receiving module on the K-

Line bus (or unit). 

Yes 

Src Addr Required to identify a specific sending module on the 

K-Line bus. 

Yes 

Payload 

Length 

The parameter payload (data) length. Yes 

Data0 – Data7 These columns provide a more advanced view that 

shows query data per bit. 

Yes 



 

Cellocator Programmer 

Manual 

 
 

 

Cellocator Programmer Manual                                                                                             Page 79 of 100  

Copyright © 2018 by Pointer Telocation, Ltd. 

 

7.4.10 The Information Tab  

The Information tab enables you to define data that is saved in the XML file, and which, in 

turn, impacts the suggested vehicle library file name.  

 

In the Library Information section, enter a Destination Region and FW Version, if 

relevant. 

In the Vehicle section, select the relevant Type, Brand, Model, Engine Type and 

Production Year. The options you select will form the name of the library file name 

when you save it (from the File menu, select Save Vehicle Library); for example, if you 

selected a Ford Transit 2.4 tdCI gasoline engine model from 2016, when saving it the file 

will have the default name of Ford_Transit 2.4 tdCI 

_2016_Gasoline_.VehicleLibrary.xml. 
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8 Working with the Nano / MultiSense application 

suite 

This section provides details of the Nano Quick Start, the Nano (Advanced Mode), and the 

Nano / MultiSense Editor, which are only relevant for CelloTrack Nano and Cello units. 

Note that the MultiSense can communicate with Cello family units equipped with the BT 

Extender unit. 

This section includes the following: 

 Working with the Nano Quick Start, see below 

 Working with the Nano (Advanced Mode), see page 80 

 Getting started with the Nano / MultiSense Editor, see page 85 

 Working with the Nano and paired MultiSense devices, see page 89 

 Working with MultiSense devices paired with Cello units, see page 97 

8.1 Working with the Nano Quick Start 

The Nano Quick Start application enables you to get up and running with a basic default 

configuration for the Nano unit. 

The Nano Quick Start is the default application launched for Nano-designated PL files. 

Note that if you want to edit any of the additional parameters in the PL file that are not 

displayed in the Nano Quick Start you can access the Nano (Advanced Mode) application, 

as described in the Working with the Nano (Advanced Mode) section. 

This section includes: 

 Entering and Exiting the Nano Quick Start, see below 

 Nano Quick Start Window Components, page 86 

8.1.1 Entering and Exiting the Nano Quick Start 

The Nano Quick Start is automatically launched when double-clicking on a designated PL 

or when opening the Cellocator Programmer (and the last PL used was for a Nano unit).  

Click  to exit the Nano Quick Start. If changes were made to the PL 

settings, you are prompted to save the changes. 
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8.1.2 Nano Quick Start Window Components 

This section describes the various components of the Nano Quick Start window, as 

described in the following sections. 

 

--------------------------------------------------------------------------------------------------- 

TIP: The Nano Quick Start window includes detailed tooltips for many of the components 

and settings displayed; hover your mouse over the setting to view the tooltip. 

--------------------------------------------------------------------------------------------------- 

8.1.2.1 Main Menu  

The Main menu options are explained in the table below. 

Menu Option Description 

Unit Displays the connected unit ID. 

Status Displays the selected COM port number (or Disconnected if a 

unit is not connected). 

Nano Battery 

Forecast 

Displays an estimation of the battery charge that remains for the 

connected Nano unit. 

Read Reads the existing settings from the connected unit. 

Write Writes the settings to the connected unit.  

The Write button turns active if any parameters were changed 

(since the last save operation) and those changes have not yet 

been downloaded to the unit. 

The Write button turns inactive if the configuration was written 

to the unit successfully and no changes have been made. 

CelloTrack Nano

& MultiSense panel

Status bar

Main menu
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Menu Option Description 

Open Enables you to search for the relevant PL file. 

Save Saves any changes to the selected PL file. 

Save as Saves the current PL settings to another file (by default, located 

under C:\ProgramData\Cellocator\Programmer). 

Advanced 

Settings 

Click on the Advanced Settings button to display two options: 

 Nano/MultiSense Advanced Settings: Launches the Nano 

/ MultiSense Editor, in which you can modify and configure 

Nano and MultiSense devices in real-time. See Getting 

started with the Nano / MultiSense Editor. 

 Global Advanced Settings: Launches the Cellocator 

Programmer application (also known as Nano (Advanced 

Mode)), in which you can modify any of the PL’s parameters, 

above and beyond the default, basic settings displayed in the 

Nano Quick Start. See Getting Started with the Cellocator 

Programmer. 

8.1.2.2 CelloTrack Nano and MultiSense Panel  

The Nano and MultiSense panel contains the main default settings for both the Nano and 

MultiSense units. Note that the MultiSense settings are only displayed when selecting the 

MultiSense unit/s connected checkbox, as shown on the following page. 

Nano settings 

Nano Section Description 

 

Remote Server Communication Settings: Includes the main 

server’s IP address and port number, as well as an option to 

periodically check for FW updates from the Cellocator 

maintenance server (called C+). 

 

Cellular Provider: Details the name, username and password of 

the cellular provider’s APN. If roaming is permitted, select the 

Roaming checkbox. To test the communication, click Test 

Communication; if successful, the following is displayed:  

 

 

Power Management: Choose from Always powered or 

Battery operation, and from Stationary (for fixed 

installations) or In motion (for units that may be mobile, such 

as those installed on a vehicle). 

 

Periodic Transmissions: Defines the period of location 

transmissions and transmissions of samples of Nano sensors.  
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Nano Section Description 

 

Temperature Range: Defines the Min – Max temperature range 

thresholds, beyond which alerts will be generated. 

 

Events and Alarms: Select the checkbox for the relevant 

events you want generated (and sent to the server). 

MultiSense settings 

The MultiSense settings are only displayed when selecting the MultiSense unit/s 

connected checkbox, as shown below. 

 

 

MultiSense checkbox
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After selecting the MultiSense unit/s connected checkbox, you should also define the 

Number of connected MultiSenses in the field next to the checkbox.  

Note that when you add more MultiSense devices, the Nano Battery Forecast at the top of 

the window will automatically reduce. 

MultiSense 

Section 

Description 

 

Thresholds: Defines the temperature range and humidity 

thresholds (for the MultiSense TH only). 

 

Periodic Transmissions: Defines the period of transmissions 

for MultiSense temperature and humidity samples.  

 

Sensors Settings: Select the checkbox for the relevant sensor 

settings you want to activate. 

 

Battery Forecast: Displays an estimation of the battery charge 

that remains for the connected MultiSense devices. 

8.1.2.3 Status Bar  

The Status bar details the hardware/firmware for the selected PL file, and details of the 

Nano unit. 

Field Description 

Hardware Details the hardware version relevant to the selected PL. For 

example: HW 122 – CelloTrack Nano 20 (Telit SE868-V2/V3 

GNSS) Cinterion EHS6A 

Firmware Details the firmware version relevant to the selected PL. For 

example: 34j 

Unit details Click to open a popup dialog that includes the following details: 

 Firmware name 

 Modem type 

 Modem firmware  

 GPS type 

 GPS firmware 

 CBLE application version 

 CBLE MAC address 
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8.2 Working with the Nano (Advanced Mode) 

The Nano (Advanced Mode), otherwise known as the Cellocator Programmer, enables you 

to edit any of the additional parameters in the PL file that are not displayed in the Nano 

Quick Start. 

 To access the Nano (Advanced Mode): 

In the Nano Quick Start window, click Advanced Settings > Global Advanced Settings 

(or press CTRL+F). The Nano (Advanced Mode) / Cellocator Programmer window is 

displayed. 

For further details on how to work with the Cellocator Programmer, see earlier sections in 

this document. 

-------------------------------------------------------------------------------------------------- 

NOTE: If you are working with a Cellocator Evaluation Suite version prior to 3.26.7.x, the 

Cellocator Programmer is automatically launched when double-clicking a Nano designated 

file.  

-------------------------------------------------------------------------------------------------- 

8.3 Getting started with the Nano / MultiSense Editor 

Using the Nano / MultiSense Editor, you can monitor the status of Nano and MultiSense 

devices in real-time (and also see statuses in a simulated environment), as well as 

configure each individual device so that it works at its optimum for the environment in 

which it is located. This section includes: 

 Entering and Exiting the Nano / MultiSense Editor, see below 

 Nano / MultiSense Editor Window Components, page 86 

-------------------------------------------------------------------------------------------------- 

NOTE: The basic settings for the Nano and connected MultiSense devices are available in 

the Nano Quick Start, as described on page 80.  

-------------------------------------------------------------------------------------------------- 

8.3.1 Entering and Exiting the Nano / MultiSense Editor 

In order to ensure synchronization between the PL and the Nano / MultiSense 

configuration, the following instructions (and order) regarding entering and exiting the 

Nano / MultiSense Editor should be kept: 

 To enter the Nano / MultiSense Editor: 

In the Cellocator Programmer window, click  to launch the Nano / MultiSense Editor. 

The Editor window opens on top of the Cellocator Programmer window and is displayed 

with the data as included in the existing PL.  

Note that if you loaded a Nano PL file, the title of the displayed window will show "Nano 

Editor"; if you load a Cello PL file, the title of the displayed window will show "MultiSense 

Editor". 
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 To exit the Nano / MultiSense Editor: 

1. From the toolbar, click  (Write to PL) to update the PL with the edited Nano / 

MultiSense configuration parameters. 

2. Exit the Editor by clicking File>Exit. 

8.3.2 Nano / MultiSense Editor Window Components 

This section describes the various components of the Nano and MultiSense Editor 

windows, as shown in the following sections. 

8.3.2.1 Nano Editor Window 

When working with the Nano and MultiSense devices, the Nano Editor enables you to 

configure and view the status of the relevant MultiSense components, and some aspects 

of the Nano (including sensor thresholds). 

 

Toolbar

Tabs

Status bar

Menu bar
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8.3.2.2 MultiSense Editor Window 

When working with Cello units and MultiSense devices, the MultiSense Editor enables you 

to configure, pair, and view the status of the relevant MultiSense components. 

 

------------------------------------------------------------------------------------------------ 

NOTE: In the MultiSense Editor window, only MultiSense devices are listed; in the Nano 

Editor window the CelloTrack Nano unit is also listed, in addition to the (up to) 16 

MultiSense devices. 

------------------------------------------------------------------------------------------------ 

8.3.2.3 Menu Bar 

The Menu options are either intuitive or explained in the table below. 

Menu Option Description 

File Includes the following options: 

 Select template (Click to select the relevant template; the 

available templates help you set the configuration of 

parameters for the first time, as described on page 91) 

 Exit 

Toolbar

Tabs

Status bar

Menu bar
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Menu Option Description 

Actions Includes the following options: 

 Read from PL (Click to resync the Nano / MultiSense Editor 

parameters with the existing PL. This is needed if you want to 

restart the Nano / MultiSense Editor parameters, or if you 

made changes to the PL parameters in the Cellocator 

Programmer window and want to update the Nano / 

MultiSense Editor with the changes.) 

 Write to PL (Click to update the PL with the edited Nano / 

MultiSense configuration parameters) 

Communication Includes the following options: 

 Request active (When checked, all the values in the Sensor 

Status tab are refreshed periodically according to the time 

defined in the status request cycle parameter below) 

 Status request cycle (Defines the frequency the cycle of 

values is refreshed in the Sensor Status tab) 

Help Includes details about the version. 

8.3.2.4 Toolbar 

The Toolbar options are explained in the Menu Bar table in the previous section. 

Icon Description 

 
Read from PL (see explanation in the 

Menu Bar section) 

 
Write to PL (see explanation in the 

Menu Bar section) 

 
Template selection (as described on 

page 91) 

8.3.2.5 Tabs 

The Nano / MultiSense Editor window has four main tabs: the Dashboard tab, the 

Sensors status tab, the Sensors Configuration tab, and the Legacy events type-11 

configuration (this tab is only displayed when loading a Nano PL file) tab. 

The Dashboard tab provides you with a real-time overview of the entire system when the 

Nano / Cello is connected to the Cellocator Programmer. The Dashboard tab is described on 

page 91. 

The Sensors status tab provides you with a real-time view of the status of the CelloTrack 

Nano unit and any of the paired 16 MultiSense devices, when the Nano is connected to 

the Cellocator Programmer. When the Nano Editor is not connected, you can modify the 

fields to adjust the dashboard indicators (especially useful for simulation purposes). The 

Sensors status tab is described on page 92. 

The Sensors Configuration tab enables you to adjust the settings of the Nano unit and up 

to 16 paired MultiSense devices. The Sensors Configuration tab is described on page 94. 
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The Legacy events type-11 configuration tab allows the definition of legacy events as type 

11 or not. The Legacy events type-11 configuration tab is described on page 97. 

8.3.2.6 Status Bar 

 

The Status bar, located at the bottom of the Nano / MultiSense Editor window, provides 

visual indication of the following: 

 Communication status: green means there is a connection between the unit and the 

Editor, red means there is no current connection. 

 Last operation activated. 

8.4 Working with the Nano and paired MultiSense devices 

This section includes the following: 

 Data flow between different parts of the Nano system, see below 

 Selecting a predefined PL template for CelloTrack Nano, page 91 

 Viewing a real-time overview of MultiSense devices and the Nano, page 91 

 Viewing the Status of Nano units and MultiSense devices, page 92 

 Configuring Nano units, page 94 

 Configuring MultiSense devices, page 95 

 Defining Legacy Events as Type 11, page 97 

In order to make things easier in regards to defining the initial PL for use with the Nano 

and MultiSense devices, use the pre-defined template to help you set the configuration of 

parameters for the first time (see page 91). When working with the Nano / MultiSense 

Editor, as described in the following sections, you can select this template from the 

toolbar or menu bar. 

8.4.1 Data flow between different parts of the Nano system 

The concept of operation and parameter flow between the four main entities (the HW, the 

main Programmer application, the storage of the PC, and the Nano Editor application 

(with its several tabs)) is as shown in the following image. 
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The Data Flow process 

1. Clicking the Upload Parameters button (labeled above as 1) reads the configuration 

file from the hardware unit to the main application.  

2. Either of the Download Parameters buttons (2) can transfer the configuration file from 

the main application to the unit. 

3. When the Nano / MultiSense Editor is launched (3), the data from the main application 

to the Nano / MultiSense Editor application is transmitted automatically.  

4. Once the Nano / MultiSense Editor application is open, it will not transfer the parameters 

automatically back and forth to the main application. This has to be done manually when 

needed by pressing either the Read from PL (3) or Write to PL (4) buttons. 

5. At any time, the configuration file from the main application only can be saved to a file 

or read from a file using the relevant buttons (5). 

6. Only when actively watching the Dashboard or Sensors status tabs (when set as the 

foreground window on your PC), the application opens a direct live link (6) with the 

hardware and displays real-time status information coming from the unit. 

7. You can disable the active link or change its pace from the Communication menu (as 

shown below). In order to change the pace, the link should first be disabled, and once 

modified, re-enabled. 

 

File saveFile open

or

Open Nano Editor or Read from PL

Write to PL

Upload parameters

Download parameters

Dashboard 
direct link

Dashboard / Sensors status tabs

Sensors configuration tab

2

1

5

3

4

6
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8.4.2 Selecting a predefined PL template for CelloTrack Nano 

The predefined templates that are included by default with the CelloTrack Nano PL enable 

you to access certain use-cases more quickly, for example by setting the configuration of 

parameters for the first time. Perform the following steps to select a template from the 

toolbar or menu bar. 

 To select a predefined PL template: 

1. From the toolbar, click , 

OR 

From the menu bar, select File>Select template. 

The Template Selector window is displayed, as shown below. 

 

Note that you can also access the PL templates from the Cellocator Programmer menu 

bar by selecting File>Select Template. 

2. Select the relevant template from the displayed list and click OK. 

Note that these templates will not “lock” any parameter values. This means you can select 

a template and it will set a number of parameters to certain values, but after that you can 

change these predefined values manually.  

8.4.3 Viewing a real-time overview of MultiSense devices and the Nano  

The Dashboard tab is the initial tab which is displayed when opening the Nano / 

MultiSense Editor. 

It provides a real-time system overview of the paired MultiSense devices and the Nano at 

a glance. For each MultiSense the label is displayed (by default "MultiSense #n" is 

displayed) in a large font, below which the index number and MAC address are also 

displayed. 
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8.4.4 Viewing the Status of Nano units and MultiSense devices 

The following procedure describes how to view the status of Nano units and the attached 

MultiSense devices. Note that if a connection is valid, the fields and dashboard indicators 

display the real-time status of the Nano unit or MultiSense devices. 

 To view the status of Nano and MultiSense devices: 

1. Click on the Sensors status tab. The current status for each of the devices is 

displayed in tabular form, as shown below. Note that the Cellocator Nano row is 

displayed only when the Cellocator Nano PL is used. 
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2. Click on the relevant row to see the dashboard indicators (located at the bottom of the 

Nano Editor window) for a specific device. 

The following dashboard indicators are available: 

 Battery capacity (in % value) 

 RSSI – communication strength in dBm. The needle indicates if the communication 

strength is good (green) problematic (yellow) or bad (red). If a MultiSense line is 

selected this indicator shows the communication strength between the MultiSense 

and the Nano. If the Nano line is selected this indicator shows the communication 

strength of the Nano with the cellular network. 

 Temperature (in °C)  

 Humidity (in % value) 

 RMS acceleration (the acceleration strength)  

 Magnetic Sensor (OPEN means the MultiSense does not currently recognize the 

magnetic sensor alongside it (indicating the door or entry point is open), CLOSED 

means the MultiSense device recognizes the magnetic sensor (indicating the door 

or entry point is closed)) 

 Orientation (displays the top view orientation of the MultiSense or Nano device) 

3. Click on the Description label if you want to edit it.  

 The new label will be associated with the MAC address and saved locally on your 

computer. 

 It will be retrieved from the local file whenever this MAC is displayed again. 

------------------------------------------------------------------------------------------------ 

NOTE: For simulation purposes (when not connected), you can adjust any of the fields to 

modify the dashboard indicators. For example, adjust the Acc X, Acc Y, and Acc Z fields to 

tilt the orientation view of the MultiSense device. 

------------------------------------------------------------------------------------------------ 
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8.4.5 Configuring Nano units 

 To configure the Nano unit: 

1. Click on the Sensors Configuration tab. The list of Nano and attached MultiSense 

devices is displayed, as shown below. 

 

2. Click on the CelloTrack Nano row (the top row) to select it. On the right of the Nano 

Editor window a Properties section is displayed. 

3. Configure the following: 

 Temperature thresholds: Define the working temperature range for the Nano 

unit by adjusting the values in the left and right boxes using the arrow buttons 

alongside each box, or drag the slider bar accordingly to adjust the range. 

 Movement event threshold: By default Impact is selected (Freefall is not 

currently implemented); drag the slider or click on the arrows to define the impact 

threshold. 

 Package open/closed light threshold: Drag the slider or click on the arrows to 

define the open/close light threshold. Note that you can click Typical closed box 

to use the recommended default values. 

------------------------------------------------------------------------------------------------ 

NOTE: You can also manually adjust the values for the above thresholds in the main 

table of displayed values; simply click in the relevant field and enter/define the 

required value.  

------------------------------------------------------------------------------------------------ 

4. Click Apply to implement your settings. 
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8.4.6 Configuring MultiSense devices 

 To configure a MultiSense device: 

------------------------------------------------------------------------------------------------ 

NOTE: It is possible to configure the MultiSense devices (as described below) before they 

are paired in the field (possible only with Nano devices). This can be especially useful in 

scenarios where you need to define a configuration of units/devices before 

implementation.  

------------------------------------------------------------------------------------------------ 

1. Click on the Sensors Configuration tab. The list of Nano and attached MultiSense 

devices is displayed, as shown in the previous section.  

2. Click on a MultiSense # row to select it (there are a maximum of 16 available 

MultiSense devices that can be paired). On the right of the MultiSense Editor window a 

Properties section is displayed. 

 

------------------------------------------------------------------------------------------------ 

NOTE: You can select multiple MultiSense lines and apply any changes to all of them 

(using the Shift / Ctrl keys).  

------------------------------------------------------------------------------------------------ 

3. Configure the following: 

 MultiSense Type:  

 Select from All sensors – MultiSense TH or All sensors except humidity – 

MultiSense according to the version of the selected MultiSense device. The 

relevant sensors are enabled in the Enable sensors section (see below). 

 TX on violation only: Select this checkbox if you want events to be 

transmitted only when they occur; otherwise transmissions will be made as 

defined (refer to the Programming Manual for more details).  

 Prevent power-down by pushbutton: Select this checkbox if you want to 

disable the option to switch the MultiSense device off via its push button. 



 

Cellocator Programmer 

Manual 

 
 

 

Cellocator Programmer Manual                                                                                             Page 96 of 100  

Copyright © 2018 by Pointer Telocation, Ltd. 

 

 Enable sensors: Select the relevant checkboxes for the sensors you want to 

enable. Note that if you do not need all sensors enabled, disable those that you 

do not need to preserve the energy of the MultiSense battery. 

 Temperature thresholds: If you selected the Temperature sensor option (in 

the Enable sensors section), you can also define the working temperature range 

for the MultiSense device by adjusting the values in the left and right boxes using 

the arrow buttons alongside each box, or drag the slider bar accordingly to adjust 

the range. 

 Humidity thresholds: If you selected the Humidity sensor option (in the Enable 

sensors section), you can also define the working humidity range for the 

MultiSense device by adjusting the values in the left and right boxes using the 

arrow buttons alongside each box, or drag the slider bar accordingly to adjust the 

range. 

 Movement event threshold: Select from Impact or Freefall; this immediately 

displays the selected option with a default threshold value which can be modified - 

you can change the value after selection by dragging the slider or clicking on the 

arrows to define the relevant threshold. 

 Package open/closed light threshold: Drag the slider or click on the arrows to 

define the open/close light threshold. Note that you can click Typical closed box 

to use the recommended default values. 

 MultiSense TX power: From the dropdown list of available options, select the 

rate at which the transmission power of the MultiSense device is set. It is 

recommended to leave at the maximum default value of 8dbm, but can be reduced 

as required (a lower transmission value will result in lower battery consumption). 

---------------------------------------------------------------------------------------------------- 

NOTE: You can also manually adjust the values for the above thresholds in the main table 

of displayed values; simply click in the relevant field and enter/define the required value.  

You can also right-click on any parameter field and select Cut, Copy or Paste as required. 

---------------------------------------------------------------------------------------------------- 

4. Click on the Description label if you want to edit it.  

 The new label is associated with the MAC address and saved locally on your computer. 

 It will be retrieved from the local file whenever this MAC is displayed again. 

5. Click Apply to implement your settings. 
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8.4.7 Defining Legacy Events as Type 11 

This section describes how to define legacy events as type 11 (by default legacy events 

are defined as type 0). This section is relevant for Nano PL files only. 

 To define legacy events as type 11: 

1. Click on the Legacy events type-11 configuration tab. The current type is 

displayed for each of the events, as shown below. 

 

2. Click on a row to select it, and in the Type column, click on the current value (by 

default, Disable). In the displayed dropdown box, select from one of the following: 

 Disable (report with type 0 message) 

 ActiveLogEvent (report as active log event with type 11 message) 

 Logged (report as regular logged event with type 11 message) 

Note that you can select multiple rows for modification using the standard Windows 

Ctrl or Shift buttons on your keyboard. 

3. Repeat as required. 

------------------------------------------------------------------------------------------------ 

NOTE: The Base Address and Bit Offset columns indicate the location of the specific 

bit in the memory. 

------------------------------------------------------------------------------------------------ 

8.5 Working with MultiSense devices paired with Cello units 

This section includes references to the segments relevant for MultiSense devices that are 

paired with Cello units. 
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 Viewing a real-time overview of MultiSense devices, see below 

 Viewing the status of MultiSense devices, see page 99 

 Configuring MultiSense devices, see page 100 

8.5.1 Viewing a real-time overview of MultiSense devices 

The Dashboard tab is the initial tab which is displayed when opening the MultiSense 

Editor. 

It provides a real-time system overview of the paired (with Cello) MultiSense devices at a 

glance. For each MultiSense device, the label is displayed (by default "#n" is displayed) in 

a large font, below which the index number and MAC address are also displayed. 
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8.5.2 Viewing the status of MultiSense devices 

The following procedure describes how to view the status of MultiSense devices attached 

to the Cello units. Note that if a connection is valid, the fields and dashboard indicators 

display the real-time status of the MultiSense devices. 

 To view the status of MultiSense devices: 

1. Click on the Sensors status tab. The current status for each of the devices is 

displayed in tabular form, as shown below.  

 

2. For details on what can be modified, see page 92. 
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8.5.3 Configuring MultiSense devices 

 To configure a MultiSense device: 

1. Click on the Sensors Configuration tab. The list of MultiSense devices is displayed, 

as shown below.  

 

2. Click on a MultiSense # row to select it (there are a maximum of 16 available 

MultiSense devices that can be paired). On the right of the MultiSense Editor window a 

Properties section is displayed. 

3. You must pair the MultiSense device with the Cello; click in the MAC address field of 

the relevant device and enter the MAC address printed on its sticker. 

4. For details on how to modify the parameters of the Properties section, see Step 3 on 

page 95.  

------------------------------------------------------------------------------------------------ 

NOTE: You can select multiple MultiSense lines and apply any changes to all of them 

(using the Shift / Ctrl keys).  

------------------------------------------------------------------------------------------------ 

 

 


